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1. Installing the Printer Driver in Windows

A printer driver is an application that sends documents to the printer. Install the printer driver 
from the supplied Product Library CD-ROM. Once installed, a variety of printer settings can 
be configured. 

In Windows XP or 2000, you must be logged into the system with administrator privileges.

If you connect the USB cable before CD installation, it is strongly recommended that you 
cancel the Found New Hardware Wizard and install the software through the CD menu.

Browsing the CD and installing each driver separately is not recommended.

1. Ensure the power for the computer and printer are turned off. 

2. Ensure that the printer is ready to print (remove packing materials, insert paper and any 
toner or ink cartridges) and then connect the computer and printer using either USB, a 
parallel cable, or a network cable. For further details on connecting the printer to the 
computer, refer to the printer’s Operation Guide.

3. Once connected, power on both devices.

• If the Welcome to the Found New Hardware Wizard dialog box displays, click 
Cancel.

4. Insert the Product Library CD-ROM into the CD drive.
Once the installation program launches, the License Agreement displays. 

If the installation program fails to launch after inserting the CD-ROM into the CD drive, 
navigate to Windows Explorer, access the CD-ROM, and double-click the Setup.exe file.
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5. Click View License Agreement to display and read the License Agreement. 

6. Click Accept to proceed.

7. Click Install Software.

8. The Welcome to the Kyocera Product Software Installation Wizard dialog box 
appears. Click Next. 

9. The Select Method dialog box appears. For the simple, default installation, select 
Express Mode, and click Next. Express mode is for USB connection only. In the Custom 
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method you are able to choose which software packages to install. If you wish to use the 
Custom method, see Custom Installation on page 9

The installation program installs the software.

During installation, if your printer is not connected and powered on, you will see a reminder to 
connect the printer to your computer. Once the printer is connected and the power is on, the 
Found New Hardware Wizard displays. If the Found New Hardware Wizard does not 
display, reconnect the USB cable between your computer and printer. 

In Windows 98 this reminder will display regardless of whether or not your printer is correctly 
connected. The Hardware Wizard will display when the printer is properly connected. 
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 The following procedures should be performed for Windows 9X and Me. 

For Windows XP, see Hardware Wizard Instructions for Windows XP on page 7. 

In Windows 2000, all USB drivers are automatically installed without action on the part of the 
user.

Express Installation
On 9x, Me and XP, the Hardware Wizard will have a line that states the type of USB 
connection that your equipment is using. It will have one of four types listed:

1. USB Composite Device

2. USB Scanner Device Interface 2

3. USB Scanner Device Interface 1

4. USB Printer Device Interface 0 

An example is shown in the figure below. All four types follow the same steps.

1. Click Next to proceed to the next step. 

2. Click the button for Search for the best driver for your device.

3. Click Next.

4. Select Microsoft Windows Update and Specify a location if they are not already 
checked. If there is no location, browse to: C:\Program Files\Kyocera\KMSL\9xDrviers. If 
you have customized your Program File directories or installation destinations, your file 
location may different. For users who accept the defaults on installation, C:\Program 
Files\Kyocera\KMSL\9xDrviers is the correct location.
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5. When you have ensured that the location is correct, click Next. 

6. Click Next to start the installation.
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When the installation of the required software is complete, the following window will display:

7. Click Finish. 

8. Click OK

9. Ensure that the file locations is C:\Program Files\Kyocera\KMSL\9xDrviers, and click OK. 
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10.Click OK.

11.Ensure that the file locations is C:\Program Files\Kyocera\KMSL\9xDrviers and click OK.

12.When the installation is complete, the Installation Completed Successfully dialog box 
appears. Click Finish to leave the install program and return to the disc main menu. 

Hardware Wizard Instructions for Windows XP

These procedures should be performed for Windows XP. 

For Windows 9x and Me, see Express Installation on page 4. 

In Windows 2000, all USB drivers are automatically installed without action on the part of the 
user.
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1. Select No, not this time and click Next. 

2. Click Next. 

3. Click Next.

4.  Click Finish.
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5. When the installation is complete, the Installation Completed Successfully dialog box 
appears. Click Finish to leave the install program and return to the disc main menu. 

Custom Installation The preceding instructions are for the Express method. This section describes the Custom 
installation method. 

In the Custom method you are able to choose which software packages to install. For 
example, if you do not want to overwrite your existing fonts, you would choose the Custom 
install mode and then clear Fonts in the Software Packages (see below) dialog box.

1. Select Custom Mode and click Next. 

2. Click the button for your connection method and click Next.
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3. Select the software packages you wish to install, and clear the ones you do not want 
installed.

4. Click Next. 

5. When the installation is complete, the Installation Completed Successfully dialog box 
appears. Click Finish to exit the Installation Wizard and return to the main menu. 

At this point, you may see a reminder to connect the printer to your computer. Once you have 
ensured that the printer is connected, if you are using a USB connection, follow the 
instructions for Express Installation on page 4.
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Other Options on the 
Installation CD

Other options available on the installation menu are Remove Software, Documentation, View 
Release Notes, and Select Language. Remove Software uninstalls any software that you 
have installed from the CD-ROM. The Release Notes is an .rtf file that lists the CD-ROM 
contents, Known Issues, and any information that did not make it into the manuals. 

Click on Documentation to see a list of available manuals. 
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You may select your interface language from the language menu. The available languages 
are French, Portuguese, and Spanish. The selected language will be displayed in the 
Installation menus.

Installing the Latest 
Printer Driver

The latest Kyocera printer driver can be obtained from http://www.kyoceramita.com/

download/.

Installing using the Add Printer Wizard

This section describes how to install a printer driver using the Add Printer Wizard.

1. Click Start in the Windows taskbar, and click Printers and Faxes to open the Printers 
and Faxes window. 

Windows 95/98/2000: Click Start in the Windows taskbar, click Settings-Printers in 
sequence to open the Printer dialog box. 

2. Click Add a printer in the Printer Tasks group box on the left. The Add Printer Wizard 
dialog box appears.
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The wizard can also be launched by clicking Add a printer in the File menu.

3. The Welcome to the Add Printer Wizard dialog box appears. Click Next and follow the 
instructions. 

4. When the Completing the Add Printer Wizard dialog box appears, click Finish.

5. The Hardware Installation dialog box appears and the Hardware Installation warning 
message displays. If the warning message appears, click Continue Anyway.

Installation of the printer driver is now complete. If prompted, restart your system.
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2. Printer Properties

This section explains how to customize the installed printer driver settings including:

• Accessing Printer Properties
• Installing Optional Devices
• User Settings
• Page Description Language (PDL) Settings
• Administrator Settings
• Compatibility Settings

Follow the steps below to set your preferred options as the default settings These printer 
settings can be changed temporarily when printing from within other Windows-based 
applications.
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Accessing Printer 
Properties

Accessing the printer driver properties

1. Click Start in the Windows® taskbar, and click Printers and Faxes. The Printers and 
Faxes window appears. 

Windows 95/98/Me/2000: Open the Start menu, and click Settings-Printers in 

sequence to display the Print window.

2. Right-click on the printer icon in the Printers and Faxes window. A drop-down list 
appears.

3. Click Properties in the drop-down list. Properties dialog box appears.
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Installing Optional 
Devices

If you use optional devices such as a paper feeder, finisher or an additional hard disk, specify 
the device on the Device Settings tab of the device properties. You can also specify the 
memory setting, PDL settings for the user, administrator settings for front panel messages 
passwords, and more.

Installing Optional Printer Devices 

1. Click the Device Settings tab.

2. In the Device Options of the Device Settings tab, enable the check boxes for any 
optional devices installed in your printer.

Some optional devices cannot be installed simultaneously. For example, a finisher and a 
booklet stitcher. After you have selected a device, all other devices will be marked with a red 
X, preventing the ability to select conflicting optional devices. For further details on which 
optional devices can be installed for each model, refer to Table of Supported Options on 
page 137.
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3. Select the check box of an optional device shown in blue, (such as the Finisher options), 
and a sub-dialog box appears with additional setting details. 

• Double-click the option to open the sub-dialog box if a device listing is already enabled.

• The Hard Disk Settings dialog box appears if you select the Hard Disk option, enabling 
the configuration of virtual mailbox settings. For further details, refer to Assigning Virtual 
Mailboxes on page 19.

4. In the Memory combo box, specify the memory capacity of your printer. This setting is 
required to optimize the downloading of printer fonts.

Finisher Punch Settings

Select the Finisher check box in the Device Options list and the Punch Unit Setting dialog 
box appears. Double-click the option to display the Punch Unit Setting dialog box if the 
device listing is already enabled. 
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Select 2 Hole, 2 & 3 Hole, or 2 & 4 Hole punch option depending on the optional punch unit 
attached to your finisher to enable hole punching.

Booklet Stitcher Punch Settings

The Booklet Stitcher feature enables you to set the number of holes punched in each printed 
page. If you enable the Booklet Stitcher check box in the Device Options list, the Punch 
Unit Setting dialog box appears. If the device listing is already enabled, double-click on it to 
display the Punch Unit Setting dialog box. 

Select the 2 Hole, 2 & 3 Hole, or 4 Hole option depending on the optional punch unit of your 
finisher to enable punching of the pages you print.

Assigning Virtual Mailboxes

If you enable the Hard Disk check box, the Hard Disk Settings dialog box appears and 
virtual mailboxes can be created. For further details, refer to Virtual Mailbox on page 113
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• The following functions can be used if a hard disk is installed: 

• Quick Copy
• Proof and Hold
• Private Print 
• Job Storage
• Temporary
• Permanent Jobs

RAM Disk Settings

The RAM disk functions as a hard disk saving print requests into the printer’s memory if a 
hard disk for printing is not installed. When a hard disk is installed, the RAM disk function is 
inactive.

Since the RAM disk is volatile memory, all data sent to the printer is lost if the power is turned 
off. 

The size of the RAM disk is specified in settings on the printer operator panel. For further 
details, consult the printer’s Operation Guide.

1. In the Device Options list, enable the RAM Disk check box. The memory capacity can 
be adjusted in the RAM Disk combo box. 

2. Specify the RAM Disk size. The maximum RAM disk capacity may vary depending on 
your printer model and installed memory.

In the example of the FS-6020 shown above, if the memory corresponds to 16 MB minus 
8 MB, the maximum available capacity for the RAM disk is 8 MB. The value in the combo box 
will not exceed 8 MB. For further details, consult the printer's Operation Guide.



Printer Properties

21

Auto Configuration The Kyocera Auto Configuration Tool (KACT) allows users to automatically configure the 
physical device settings of a printer on the Device Settings properties page. Auto Configure 
can detect printer devices such as input devices, output devices, RAM disk size, and hard 
disk size. Then it sets the Device Options list on the Device Settings properties page. Auto 
Configure keeps the printer driver’s Device settings consistent with the actual printer devices.

Auto Configure currently supported these ports for Windows operating systems:

• Windows 98 & ME – KPrint ports (Raw mode, LPR, and IPP) only
• Windows NT 4.0 – KPrint ports (Raw mode, LPR, and IPP) only
• Windows 2000 – TCP/IP Ports and KPrint Ports (Raw mode, LPR, and IPP)
• Windows XP – TCP/IP Ports only

 
TCP/IP port can be either an IP address or the printer name (Host name). 

Windows 95 is not supported by KACT.

1. Click Auto Configure.

An “in progress” message will display.

The checkbox settings on the Device Options: list will be changed and the 3D image will be 
updated according to the device options installed. Memory and RAM Disk information will 
also change by the settings information returned. When completed, this message will display:



22

The Auto Configure tool can not communicate with a printer if the printer is powered off or in 
the middle of booting up process. In such cases, Auto Configure will display the following 
message after the time out.

User Settings

The following user information can be configured by clicking the User... button on the Device 
Settings tab.

• Identification
• Unit of Measurement
• Language Preference Selection

Identification

You can display the user information for the current print job on the printer operator panel. For 
further details, refer to Job Name Display on page 26.

1. On the Device Settings tab, click User....

2. The User Settings dialog box appears. In the User Name and Department fields, enter 
up to 31 characters.

• Enter the preferred name in User Name field. 
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• Enter the group to which the user belongs in the Department field.

Unit of Measurement

Select the inches or centimeters options tin the following locations:

• Custom Paper Sizes setting in the Custom section on the Media tab
• Separation setting in the Position section on the Watermark tab
• Advanced Layout Settings on the Layout tab

In the User Settings dialog box choose from inches or millimeters.

Language Preference Selection

The Language Preference option specifies the language of the driver tabs excluding General, 
Sharing, Ports, Advanced, Color Management, and Security. 

Select the Language Preference check box and select the preferred language from the 
Language Preferences drop-down list.
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Page Description 
Language (PDL) 
Settings

You have the option to change the Page Description Language (PDL) by clicking the PDL 
button on the Device Settings tab. Depending on your printer model, available PDLs may 
vary. You can choose from PCL XL, PCL 5e, or KPDL. We recommend PCL XL. If you select 
one of the PDLs options, the selection displays in the lower corner of the 3-D image.

If you receive a PDL printing error, select a different PDL and try again. 

1. On the Device Settings tab, click PDL....

2. The PDL Settings dialog box appears. Select PDL from the Page Description 
Language drop-down list. Refer to the table below for options and descriptions.

Options Descriptions
PCL XL 
(color and monochrome 
printers)

The most recent version of HP PCL and PCL 6. This PDL 
includes 
PCL 5e features.

PCL 5e 
(monochrome printers)

Specifies HP PCL 5e as the PDL. The GDI compatible mode 
is selected automatically.

KPDL 
(color and monochrome 
printers)

Specifies KPDL, which is compatible with the Adobe 
PostScript 3 language, as the PDL. KPDL is used when 
printing from applications that support PostScript 2 or 3. 
An optional KPDL upgrade kit may be required for some 
models. The GDI compatible mode can also be used.
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• In GDI compatible mode, vector graphics are rasterized for printing as bitmap images. Use 
the GDI compatible mode option to improve the graphic output quality created by the 
application.

• Due to memory restrictions, this feature is not available in certain printing environments and 
if the KPDL (PostScript-compatible) option is selected.

3. The Settings... button is available when the PDL is set to PCL XL, or KPDL.

PCL XL

KPDL

Option Description
Disable Auto Media Type 
Switching

Disables the Media Type settings on the Media tab.

Options Descriptions
Allow Data Passthrough Reduces errors when printing complex jobs from 

applications that use the PostScript format.

Allow Native 
TrueType Download

Improves the print quality and speed when using TrueType 
fonts.
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Administrator 
Settings

The following settings can be specified by clicking the Administrator... button on the Device 
Settings tab. We recommend that the Device Settings should only be changed by the system 
administrator or authorized personnel.

･ Job Accounting
･ Job Name Display
･ Setting the Administrator Password
･ Changing the Administrator Password
･ User Login (FS-1118MFP / KM-1820 only)

Job Accounting

Job Accounting settings are specified by the system administrator to implement an 
accounting system for assessing charges or other budgetary applications. The accounting 
system can help manage or restrict the printing volume by department. For further details, 
contact your system administrator or authorized personnel. 

For further details, refer to Job Accounting in the Operation Manual on the supplied CD-ROM. 
This function is available on FS-6020 and later printer models. 

Job Name Display

You can specify from the print operator panel to display the user name and department for the 
current job.

1. On the Device Settings tab, click Administrator....
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2. The Administrator Settings dialog box appears. Select the Front Panel Message check 
box. Select the following options to display during a print job: 

3. Enter the password when the Set Password dialog box appears. 

4. Click OK. 

Setting the Administrator Password

By setting a password, you can protect and restrict the settings made in the Administrator 
Settings dialog box.

Options Description
Display Job Name Displays the job name during printing. The job name is the name sent 

from the application to the printer driver or it can be selected in the Job 
Settings dialog box before printing. 

Display User Name Displays the user name during printing. The user name is the 
information entered according to the instructions in Identification on 
page 22.

Display 
Department

Displays the user group during printing. The group name is the 
information entered according to the instructions in Identification on 
page 22.
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1. Select the Lock these Settings check box to access the Set Password dialog box.

2. In the Set Password dialog box, enter the new password in the New password field. 
Re-enter the password in the Confirm new password field and click OK. 

The password must be between 4 to 16 characters.

Changing the Administrator Password

1. On the Device Settings tab, click Administrator....
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2. The Enter Password dialog box appears. Enter the password and click OK.

3. The Administrator Settings dialog box appears. Disable the Lock these Settings check box. 
A Password dialog box appears. Click OK. 

Refer to Setting the Administrator Password on page 27 to enter a new password.

User Login (FS-
1118MFP / KM-1820 
only)

When User Login is set to ON at the printing system, User Login allows you to limit printing 
privileges to specified users, which is useful for secure printing and job accounting. This 
feature allows for job accounting by user, which differs from the method by division or 
department in the Job Accounting feature. 

A maximum of 20 User IDs and passwords can be registered at the printing system, and 100 
User IDs and passwords can be stored in the printer driver for use with multiple printing 
systems. Once User IDs are assigned, you can type the User ID and password. Both User ID 
and password must be numbers, up to 16 digits. 

The User Login password is different from the Administrator’s password used for Lock these 
Settings. 

Use Specific User ID

Allows you to establish a User ID and password for User Login purposes. The User ID and 
password must be registered in the printing system. Using this option gives the Administrator 
control over the use of User IDs. 
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Prompt for User ID

Allows you to use User Login without creating a User ID List in the driver. When sending a 
print job, type a User ID and password when prompted, then click OK to print. Using this 
option allows the user to select from User IDs registered in the printing system.

If you type a User ID that is not registered in the printing system, the job will not print.
 

 Prompt for User ID and Validate

Allows you to use the User IDs entered in the User ID List of the driver. When sending a print 
job, type a User ID and password when prompted, then click OK to print. Using this option 
ensures that the job will print, by verifying that the selected User ID is saved in the driver.

Verify ID for Each Login User

• Allows you to use User Login by searching for a User Name from the User ID List. 

• If a match is found, the User ID will be used for the print job. 

• If a match is not found, the driver will check for Administrator or User privileges: 

• A user with Administrator privileges will be prompted to enter a User ID and 
password to print the job. The driver will search for a Windows Login User Name 
and add this name with the User ID and password to the User ID List in the driver. 

• If the user has only User privileges, the print job will be cancelled, and the user will 
be prompted to see the Administrator for printing privileges. 

User ID List

Allows you to add, delete, edit, import, or export User IDs and passwords from the User ID 
List of the driver. 

Once a User ID list is created, the list can be exported as a group by saving it as a text file 
(.csv). To import a User ID list, browse for an existing list and save it in your printer driver. 
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Saving, Editing, and 
Deleting User IDs

Saving User IDs creates a User ID List so that User Login can be used in User Login mode. 
The printer driver stores a maximum of 20 User IDs.

To save a User ID, follow these steps:

1. In the Device Settings, tab, click Administrator, to open the Administrator Settings 
dialog box. 

2. Select User Login. 

3. Click User ID List. 

4. In the User ID List dialog box, click Add. 

5. In the Add User ID dialog box: 

• Under User ID, type a numerical User ID, up to 16 digits. 
• Under Password, type a numerical password, up to 16 digits. 

Optional: Under User Name, you can type a name, up to 20 characters. This name will be 
displayed in the User ID List and can be used with Verify ID for Each Login User. 

6. Click OK in the Add User ID and User ID List dialog boxes. 

The saved User ID will be available in the User ID List.

To edit User ID information, follow these steps:

1. In the Device Settings tab, click Administrator, to open the Administrator Settings 
dialog box. 

2. Select User Login. 

3. Click User ID List. 

4. In the User ID List dialog box, select the User ID to be edited. 

5. Click Edit. 

6. Make changes in User ID, Password, or User Name. 

7. Click OK in the Edit User ID dialog box. 

8. Click OK in the User ID List dialog box. 

To remove a User ID, follow these steps: 

1. In the Device Settings tab, click Administrator, to open the Administrator Settings 
dialog box. 

2. Select User Login. 

3. Click User ID List. 

4. In the User ID List dialog box, select the User ID you want to remove. 
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5. Click Delete. 

6. Click OK in the User ID List dialog box. 

Importing and 
Exporting User IDs

You can import an established group of User IDs into the printer driver. This allows multiple 
users to choose from a standard User ID List in User Login. The imported list will replace all 
existing User IDs in the driver.

To import User IDs, follow these steps:

1. In the Device Settings tab, click Administrator, to open the Administrator Settings 
dialog box. 

2. Select User Login. 

3. Click User ID List. 

4. In the User ID List dialog box, click Import. 

5. Browse for a valid User ID List file (.csv), select it, and click Open. 

The selected list of User IDs will be displayed in the User IDs list.

6. Click OK to save the list in the driver. 

You can save (Export) a list of User IDs, making them available to other users. 

To export User IDs, follow these steps:

1. In the Device Settings tab, click Administrator, to open the Administrator Settings 
dialog box. 

2. Select User Login. 

3. Click User ID List. 

4. In the User ID List dialog box, click Export. 

5. Browse to the desired directory, name the file, and click Save. 
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Printing in User Login 
Mode

After User IDs are assigned and User Login mode is set to On at the printing system, you can 
choose User Login to print in User Login mode. 

To print in User Login mode with a Specific User ID, follow these steps:

1. In the Device Settings tab, click Administrator, to open the Administrator Settings 
dialog box. 

2. Select User Login. 

3. Select Use Specific User ID and type a User ID and password from the User IDs that are 
registered in the printing system. 

4. Click OK in the Administrator Settings dialog box and in the Device Settings tab. 

5. Open the application and print the document. 

To print in User Login mode with Prompt for User ID, follow these steps:

1. In the Device Settings tab, click Administrator, to open the Administrator Settings 
dialog box. 

2. Select User Login. 

3. Select Prompt for User ID. 

4. Click OK in the Administrator Settings dialog box and in the Device Settings tab. 

5. Open your application and print the document. 

6. Click OK. 

To print in User Login mode with Prompt for User ID and Validate, follow these 

steps:

1. In the Device Settings tab, click Administrator, to open the Administrator Settings 
dialog box. 

2. Select User Login. 

3. Select Prompt for User ID and Validate. 

4. Click OK in the Administrator Settings dialog box and in the Device Settings tab. 

5. Open the application and print the document. 

6. When the Print Options dialog box appears, type a User ID and password from the User 
ID List in the driver. 

7. Click OK. 
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To print in User Login mode with Verify ID for Each Login User, follow these 

steps:

1. In the Device Settings tab, click Administrator, to open the Administrator Settings 
dialog box. 

2. Select User Login. 

3. Select Verify ID for Each Login User. 

4. Click OK in the Administrator Settings dialog box and in the Device Settings tab. 

5. Open your application and print the document. 

The driver will search for a User Name in the User ID list. 

• If a match is found, the User ID will be used for the print job. 
• If a match is not found, the driver will check for Administrator or User privileges: 

• A user with Administrator privileges will be prompted to enter a User ID and 
password to print the job. The driver will search for a Windows Login User Name 
and add this name with the User ID and password to the User ID List in the driver. 

• If the user has only User privileges, the print job will be cancelled, and the user will 
be prompted to see the Administrator for printing privileges. 

6. Click OK. 
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Compatibility 
Settings

Compatibility settings can be adjusted by clicking the Compatibility... button on the Device 
Settings tab.

Compatibility settings are specified when:

• printing from applications that save paper source information within documents
• the paper source settings are specified by your system environment.

Changing the device settings may result in printing errors. For further details on changing 
these settings, contact your nearest Kyocera dealer.

Setting the Device Compatibility

1. On the Device Settings tab, click Compatibility....

2. The Compatibility Settings dialog box appears. From the list in the Media Source 
Enumeration group box, select the paper supply method.

The current value is listed in the Enumerated Value box. 

3. Enter the new value for the Enumerated Value and click Apply. You can also restore all 
the parameters to the default by clicking Reset.
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4. Select the Disable Face-up Reverse Page Order check box to prevent Reverse Order 
Printing when output is face up.

5. Select the Ignore Application Collation check box to bypass the Collate setting in the 
application, and give priority to the printer driver setting.

Click Printing Preferences on the General tab in the Properties dialog box to access 
collated printing options. 
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3. Printing from Applications

This section describes the following printing tasks when printing from Microsoft® Windows® 
applications.

• Basic Printing Tasks
• Duplex Printing
• Reverse Order Printing
• Printing Watermarks
• Adjusting Image Settings
• Adjusting Color

Basic Printing Tasks The steps required to print a document created with an application are explained below. You 
can select the printing paper size and output location.

Basic Printing

1. Insert the proper paper size (such as A4) into the printer's paper cassette.

2. From the application’s File menu, select Print. The Print dialog box appears.

3. Click Printer Name to open a drop-down list. All the installed printers are listed. Select the 
desired printer. 
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4. Specify the number of copies to print in the Number of copies field. You can print up to 
999 copies. When printing two or more copies, enable the Collate check box for collation. 

When using Microsoft® Word®, we recommend that you click Options... and select Use printer 
settings for the default tray.

5. Click OK.
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6. Click Properties... to access the Properties dialog box.

7. On the Media tab, click the Page Size drop-down list and select the appropriate page 
size. 

• For best results when printing on transparencies or recycled paper (the back side of paper 
which has already been printed on), click the Media Type drop-down list and select the 
media type. For further details, refer to Matching the Paper Size before Printing on page 
44.

• The printer automatically selects paper size that matches the size specified above. A 
message displays requesting you to fill the multi-purpose tray if the proper paper size is not 
available.

• Click the Source drop-down list to specify the paper cassette for printing.



40

8. Choose either Portrait or Landscape to match the document page orientation. You can 
rotate the document 180 degrees by enabling the Rotated check box.

The Rotated setting is required when stapling the upper-right corner of the document. For 
further details, refer to Reverse Order Printing on page 53.

9.  Click OK to return to the Print dialog box.

10.Click OK to start printing.
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Using a Different Print Size

This section describes how to print documents of different sizes than the original document. 
The document image is automatically adjusted to match the output page size.

1. In the Properties dialog box, click the Media tab.

2. In the Page Size drop-down list, select the original paper size. Click the Print Size drop- 
down list and select the preferred output paper size.

3. Confirm that the proper paper size is loaded. Click OK to return to the Print dialog box.

4. Click OK to start printing.

The proportion of the source document page size is compared to the output paper size by 
using the Page Size feature. 

Scaling enables you to select a percentage to increase or decrease the original image 
relative to the original page size. Refer to Scaling on page 43.

Select Same as Page Size in the Print Size list to restore the output page size.
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Printing Multiple Pages Per Sheet

You can print by arranging multiple pages of the source document on a single sheet of paper. 
When this function is enabled, the Scaling option is disabled.

1. In the Properties dialog box, click the Layout tab.

2. Specify the number of source pages in the Pages per Sheet drop-down list. You can 
select the horizontal direction for the page layout using Layout (Sequence). 

If you select four pages per sheet, then four pages are printed on a single sheet as shown in 
the dialog box in the example above. If AUTO is selected as layout, pages are arranged from 
the top left corner to the bottom right corner.

Enabling the Print Borders check box displays the page borders of each page.

When KPDL is set for the PDL, printing may be affected in some applications. Change the 
setting to PCL XL or PCL 5e, or set Passthrough mode in the KPDL mode settings to Off. 
For further details on changing the PDL, refer to Page Description Language (PDL) 
Settings on page 24.
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Scaling

Based on the page and print size specified in the Print Size on the Media tab, you can 
reduce or enlarge the image from 20 to 500% before printing. However, only one page per 
sheet can be printed. 

1. Click the Layout tab in the Properties dialog box, and enter the scale percentage into the 
Scaling (20-500%) field, or adjust the value as needed.  For Windows 95 or 98, scaling is 
20 - 480%.

2. If you click Advanced..., you can adjust the outside margins in a range from 
5.0 to 25.4 MM. 

• For outside margins to the left of the page, enter a number into the Left (Long Edge) - Width 
combo box. 

• For outside margins to the top of the page, enter a number into the Top (Short Edge) - Width 
combo box. 

• Select the Reduce Image to Fit check box if the printing data extends beyond the 
edge of the paper when setting a binding margin. The margins are reduced to match 
the page size adjustment. 

When you want to change the page size (for example, to enlarge an A4-size brochure for 
printing on A3 paper), refer to Using a Different Print Size on page 41. 

Left (Long Edge) Top (Short Edge)

Reduce Image 
to Fit 
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Matching the Paper Size before Printing

The printer automatically selects the paper size specified in the Page Size setting on the 
Media tab by default when you are printing on regular paper. However, the printer supports a 
wide variety of printing media depending on your printer model.

You can specify the media type in the Media Type setting for automatic paper source 
selection when using recycled paper, labels, or transparencies. You can also specify the 
finishing settings for best results. This function can be disabled in the PCL XL detail settings. 
For further details, refer to Page Description Language (PDL) Settings on page 24.

Labels, transparencies, and envelopes can be printed using the multi-purpose tray. Ensure 
the paper is properly loaded by following the instructions outlined in the supplied printer's 
Operation Guide.

When paper is loaded properly in the paper cassette, the printer can automatically detect the 
paper size. However, it is necessary to use the print operator panel on the printer to assign 
the media type of the paper cassette so that the printer can recognize it. The steps to specify 
the media settings are listed below.

1. Load the paper in a paper cassette or the multi-purpose tray.

Use the multi-purpose tray in cassette mode (the default). For further details on multi-purpose 
tray modes, refer to the printer's Operation Guide.

2. Specify the media type in the print operator panel on the printer.

3. Access the printer Properties and click the Media tab.
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4. Select the document paper size from the Page Size drop-down list.

5. From the Media Type drop-down list, select the type of media for printing, then click OK. 
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Options available in the Media Type drop-down list are as follows.

Once printing begins, the printer automatically selects the paper to match the paper size and 
specified media type.

If the paper loaded does not match the size, type, or both, a message displays requesting 
you to load paper in the multi-purpose tray.

Media Type Usable Paper Cassettes
Plain 64 to 90 g/m2 All

Transparency Multi-purpose tray (MP tray)

Preprinted All

Labels Multi-purpose tray (MP tray)

Bond (securities) All

Recycled All

Vellum Less than 64 g/m2 All

Rough 90 to 200 g/m2 Multi-purpose tray (MP tray)

Letterhead All

Color 64 to 90 g/m2 All

Prepunched All

Envelopes Multi-purpose tray (MP tray)

Card Stock All

Thick Multi-purpose tray (MP tray)

High quality All

Custom (1-8) Refer to the next section.
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Printing on Paper of Non-Standard Sizes

The printer can print on custom sizes of paper by defining them as custom paper sizes. 

• For custom paper, supply the paper using the universal (adjustable) paper cassette or the 
multi-purpose tray. Custom paper sizes are not supported in the models listed below: 

   FS-1700, FS-6300, FS-6700, FS-6700S, FS-6800, FS-7000, and FS-9000. 

Follow these steps to save custom page sizes in the printer driver. 

1. Load the custom paper into the printer. For further details, refer to the printer's Operation 
Guide.

2. Click Start in the Windows taskbar to access the printer driver properties and then select 
the Printers and Faxes. The Printers and Faxes window appears.

Windows 95/98/Me/2000: Access the printer driver properties by clicking the Start button in 
the Windows task bar and then selecting the Printers window.

3. Right-click the printer icon to access the Properties dialog box.

4. Click Printing Preferences to open the Printing Preferences dialog box. Click the 
Media tab.

5. Click Custom.... The Custom Paper Sizes dialog box appears.
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6. Click Add.... The Edit Paper Size dialog box appears. Enter a name for your custom 
paper size in the Name field. 

The name can be up to 31 characters. 

7. Enter the measurements in the Height and Width boxes in millimeters or inches. (Units 
are selected from the User dialog box of the Device Settings tab in the Properties dialog 
box.)

The following sizes are available for custom paper.

8. Click OK to save the page size and return to the Custom Paper Sizes dialog box. 
Confirm the name of paper size you just added.

9. Click OK.

Size Cassette MP tray Duplexer unit
Minimum (A4 printers) 148 × 210 MM.

(5.8 x 8.3 inches)
70 × 148 mm (Portrait) 148 × 216 mm

Largest (A4 printers) 216 × 356 MM.
(8.5 x 14 inches)

216 × 356 mm (Portrait) 216 × 356 mm

Minimum (A3 printers) 148 × 210 MM.
(5.8 x 8.3 inches)

70 × 148 mm 148 × 210 mm

Largest (A3 printers) 297 × 450 MM.
(11.7 x 17.7 inches)

310 × 458 mm 297 × 431.8 mm

Width = 150 mm

H
ei

gh
t =

 2
00

 m
m

Sample Paper Measurements (150 mm x 200 mm)



Printing from Applications

49

Repeat the steps above if you want to add other custom paper sizes. A maximum of 20 different 
paper sizes can be added.

Printing with Custom Paper Sizes

1. From the applications’s Printer Properties, access the Print dialog box. (Select Print 
from the File menu.)

2. On the Media tab, select the name of your saved paper size in the Page Size drop-down 
list.

3. Select the source cassette for the custom paper from the Source drop-down list.

4. Click OK to return to the Print dialog box.

5. Click OK to start printing. 
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Duplex Printing This section describes how to enable the duplex printing option. In order to activate this 
printing option, the duplex unit must be installed, and additional memory may be required 
depending on the printer model. For further details, refer to the printer's Operation Guide.

In the table below, the paper sizes and media types are not available for duplex printing:

Printing on Both Sides

1. From the application’s Print dialog box, access the Properties. (Select Print from the 
File menu and select Properties.)

2. Click the Layout tab. 

3. Select the Print on Both Sides (Duplex) check box. Choose either Flip on Long Edge 
or Flip on Short Edge. 

Paper size Media Type
A3 wide

A6

B6 

Postcards

Double postcards

Envelopes

Western size 2 (114 × 162 mm)

Western size 4 (105 × 235 mm)

Transparencies

Labels

Thin paper 

Envelopes 

Postcards

Portrait

Landscape

Portrait

Landscape

Flip on Long Edge Flip on Short Edge
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4. Click OK to return to the Print dialog box.

5. Click OK to start printing. 

Manual Duplex Manual duplex enables printing on both sides of a sheet by ordering the print job so that after 
the first half of the print job has been printed, the job can be flipped over and fed from the 
cassette for the second side printing. Manual Duplex is not available when settings are made 
in the Advanced dialog box, accessed from the Media tab.

The steps for using Manual Duplex may vary, depending on your printer, what printer 
accessories you have installed, and what application you are printing from. 

The Print dialog boxes of some applications allow you to print just the odd or even pages so 
that you can use manual duplex, as shown in the two examples below. 

The Microsoft Word Print dialog box has a Manual Duplex checkbox, as show above. When 
this option is selected, the odd pages are printed and then a message (shown below) 
displays telling the user to flip the printed pages over and re-insert them in the input bin of the 
printer.

Adobe Acrobat
Adobe Framemaker

Microsoft Word
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Some Kyocera printers have a manual duplex setting in Printer Preferences, on the Layout 
page. Instructions for using this method for manual duplex printing are below. If the 
Properties or Preferences dialog boxes for your printer don't have manual duplex settings, 
look for an option to print just odd or even pages in the Print dialog box of the application you 
want to print from, as shown above."

Manual Duplex Settings

• The printer must be set to a local port. 
- OR - 

• The Source selection must be Cassette 1 or Cassette 2. 

When using a network port, select Enable Manual Duplex on Network Port in the 
Compatibility Settings dialog box, accessed from the Device Settings tab. Manual Duplex 
cannot be used on a network port in Windows 9x.

To print on both sides, follow these steps:

1. In the Media tab, select Cassette 1.

2. In the Layout tab, select Print on Both Sides (Manual Duplex). 

3. Select Flip on Long Edge or Flip on Short Edge. 

4. Select Print Instructions to print an instruction sheet. Follow the printed instructions for 
placing the pages back into the cassette after the first side is printed. 

- OR -

Clear Print Instructions and follow steps 5-7.

5. Click OK in the Properties dialog and Print dialog. 
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The even-numbered pages will be printed.

6. When printing stops, remove all printed sheets from the output tray. 

7. With Flip on Long Edge selected, turn the stack over on the long edge and put the pages 
into the cassette. 

8. With Flip on Short Edge selected, turn the stack over on the short edge and put the 
pages into the cassette. 

9. Click OK in the Manual Duplex Instruction dialog box. 

The odd-numbered pages will be printed.

Reverse Order 
Printing

Prints document pages in reverse order, from the last page to the first. 

When heavy or other special papers are printed face up, the reverse order printing function 
places the order of pages into numerical order as shown below. 

Print pages in reverse order

1. Access the Properties dialog box and click the Output tab.

2. Select the Output tray from the Output to drop-down list. 

3. Select the Reverse Page Order check box in Finishing Options.

4. Click OK to return to the Print dialog box.

5. Click OK to start printing.

1
2

3

3
2

1
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Printing Watermarks
When printing using watermarks, your preferred text is printed in the document background. 
You can choose one of four standard watermarks or enter your own text.

Selecting the Watermark

1. From the application’s Print dialog box, access the Properties. (Select Print from the 
File menu and select Properties.)

2. Click the Watermark tab.

3. Clear the Disable Feature check box. 

4. Select from the Watermark Selection drop-down list. 

The Watermark Selection drop-down list displays four standard and customized watermarks. 
For further details on adding watermarks, refer to Adding Watermarks on page 55.

Standard Watermarks
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Adding Watermarks

You can enter the text for a new watermark. The text font, color, size, and style can be 
adjusted.

1. From the application’s Print dialog box, access the Properties. (Select Print from the 
File menu and select Properties.)

2. Click the Watermark tab.

3. Clear the Disable Feature check box. 

4. Click Add.... The Watermark Properties dialog box appears. 

5. Click the Text Definition tab. 

6. Enter a name for your watermark in the Watermark Description field, and enter the text 
to be printed as a watermark in the Watermark Text field. 
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7. In the Text Attributes section, specify the Font. Select a font from the Font drop-down list. 

8. In the Text Attributes group box, specify the Color setting.

• Monochrome printers: Select 10% Gray to 90% Gray or Black in the Color drop- 
down list. 

• Color printers: Select from the Color drop-down list, or select Custom to choose 
additional colors.

9. In the Text Attributes group box, specify the font Size. The font size is measured in 
points.



Printing from Applications

57

10. In the Text Attributes group box, specify the typeface Style. From the Style drop-down 
list, choose from regular, italic, bold, or bold and italic. 

11. Click OK.

Selecting and Creating Custom Colors (Color printers only)

In the color setting, selecting the Custom option displays the standard Windows colors. In 
addition to the basic system colors, you can also create customized colors.

1. When you set the color in the Text Attributes, select Custom... from the Color drop-
down list and click the [...] button, the Colors dialog box appears. 

• Click a color in the Basic colors group box, and then click OK. Continue to step 6. 

• Click the Define Custom Colors button to open the color matrix and create a 
customized color. 
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2. On the color matrix, enter the numerical values for the hue, saturation, and luminosity 
levels. The created color appears in the Color/Solid box. 

• Hue and Saturation (Sat) Adjustment: 
   - Click and drag the pointer left/right or up/down to adjust the hue and saturation
      levels.

• Luminosity (Lum) Adjustment:
- Click and drag the slider on the right of the color matrix to adjust the luminosity
   level.

3. Click the Add to Custom Colors... button to add your color to the custom colors. 

4. Click OK to save the custom colors. 

5. Click OK to return to the Watermark Properties dialog box.

6. In the Text Attributes group box, specify the font Size. Adjust the value of the size box as 
needed. The font size is measured in points.

7. In the Text Attributes group box, specify the Style of typeface. From the Style drop-
down list, choose from regular, italic, bold, or bold and italic. 

8. Click OK.

Luminosity 
Adjustment



Printing from Applications

59

Positioning Watermarks

1. In the Watermark Properties dialog box, click the Position tab.

2. Select Center on Page or User Defined to specify the text position.

• User Defined: Bases the watermark text position on the X and Y values for the 
horizontal and vertical coordinates.

• Center on Page: Places the watermark text in the center of the page. 

Manual Adjustment: Select the Move option and hold the left mouse button while dragging 
the watermark image on the left to the desired position. 

3. Specify the Text Angle. Click to select a preset Diagonal display (slanted to the upper 
right) or to select Angle, which enables you to enter your preferred angle (measured 
counterclockwise from 0 to 360 degrees).

• Angle: Drag the slider horizontally or enter the value.The angle of the text can be 
manually adjusted by placing the mouse pointer on the center or end of the text and 
dragging it to the desired position. 
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• Manual Adjustment: You can select Rotate and hold the left mouse button while dragging 
the watermark image at left to the desired angle. 

• Select User Defined in the Text Position field and then Angle in the Text Angle. Activate 
the Select Rotation around Center of Text check box.

4. Specify the Text Display. Adjust the number of watermarks printed and the amount of 
separation space between the text.

• Enter the number of watermarks in the Count count box, or drag the slider to adjust the 
value.

• Enter the value for separation between watermarks in the Separation combo box in 
millimeters or inches in the User Settings dialog box on the Device Settings tab, or 
use the spin box to adjust the value. 

5. Click OK.

Deleting Watermark Text

1. Clear the Disable Feature check box on the Watermark tab. 

2. From the Watermark Selection drop-down list, select the watermark text you wish to 
delete. Click Delete. 
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3. Click OK to confirm the deletion. 

Editing Added Watermarks

Edit your own watermarks by following the steps below. When editing your added 
watermarks, you can change the watermark text, font, color, size, and style.

1. Clear the Disable Feature check box on the Watermark tab. 

2. From the Watermark Selection drop-down list, select the watermark text for editing.

3. Click Edit... . The Watermark Properties dialog box appears. 

Adjust the text position and other settings as desired. For further details, refer to Adding 
Watermarks on page 55, step 5 to 10 and Positioning Watermarks on page 59, step 1 to 3.
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Watermark Page Settings

1. In the Page Specification group box, choose from All pages, First page only, All pages 
except first page, or Only on specified pages for printing the watermark text. 

Enter the pages in the text box to print the watermark on specific pages. For example, to print 
the watermark on pages 1, 3, 5, 6, 7, 8, 9, 10, 11, and 12, enter [ 1,3,5-12 ].

2. Select the Print Onto Cover check box to select the cover page for printing the 
watermark. 

Enable the Cover Mode option in the Advanced Media Settings on the Media tab to print 
the watermark text on the front or front and back covers. For further details, refer to Printing 
with Covers on page 88.

3. Click OK.
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Adjusting Image 
Settings

The settings for Print Quality, Grayscale Adjustment and Font Settings are described 
below. Color printers also offer adjustment options in the Color Adjustment settings of the 
Color Adjustment dialog box.

Print Quality 

You can specify the printer settings for Resolution and EcoPrint.

1. From the Print dialog box of the application, access the printer Properties.

2. In the Properties dialog box, click the Imaging tab.

Options Descriptions
Resolution The number of dots printed in one inch. Higher resolution enables 

more accurate printing of specific details.

EcoPrint Reduces the amount of toner placed on the printed page, 
extending the life of the toner cartridge, making it both economical 
and ecological. Because toner saturation is reduced, the entire 
image, text and graphics, appears lighter in the printed job. 
EcoPrint does not increase print speed.

Color Printers

Monochrome Printers

Settings for Monochrome Printers
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3. Click to select the Print Quality from the Print Quality drop-down list.

When you select Custom for the Print Quality, then click the [...] button next to drop-down 
list, the Print Quality Settings dialog box appears. Refer to the following table to set the 
Resolution, Kyocera Image Refinement, and EcoPrint features. 

These options enable you to extend the use of your toner cartridges by adjusting the printing 
resolution. For color printers, these options are only available for monochrome printing.

Print Quality Options Descriptions
High quality Prints using the highest printer resolution. 

Proof (monochrome 
printers only)

Prints using the second-highest level of resolution. 

Draft Reduces the amount of toner placed on the printed page, 
extending the life of the toner cartridge, making it both 
economical and ecological. Because toner saturation is 
reduced, text and graphics will appear lighter on the printed 
page. 

Custom You can specify your preferred combination of settings for 
Resolution, Kyocera Image Refinement, and EcoPrint. For 
further details, refer to the instructions below.

Options Descriptions
Resolution (monochrome 
printers only)

Choose from 1200 dpi fast mode, 600 dpi, or 300 dpi.

The printer models FS-1800, FS-1800+, and FS-3800 support 
1200 dpi fast mode.

Kyocera Image 
Refinement

Smoothes the outline of text and vector graphics. For color 
printers, this option is only available when printing in 
monochrome mode.

EcoPrint Depending on the model, choose from On, Off, 75%, or 50%. 
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Grayscale Adjustment

The Grayscale Adjustment setting is used for adjusting the brightness and contrast of 
graphics produced by monochrome printers. This setting is available on color printer models 
when the monochrome option is active. Text remains unchanged. 

Use the mouse to drag the slider horizontally toward (+) or (-) for Brightness and Contrast 
in the Grayscale Adjustment group box. Alternatively, click the arrows at the right to 
increase or decrease the values in the spin boxes. 

Grayscale Adjustment 
Options

Descriptions

Brightness Adjusts the brightness of graphics. The darkest setting is -100 
and the brightest is +100. Choose 0 (zero) for a regular level of 
brightness. 

Contrast Adjusts the contrast (the proportion of light to dark) of graphics. 
The faintest contrast setting is -100 and the strongest is +100. 
Choose 0 (zero) for a regular level of contrast.



66

Font Downloading

This setting specifies the method used to send TrueType fonts to the printer during printing.

1. Click Font Settings.The Font Settings dialog box appears. 

2. Select one of the three following methods for sending TrueType Fonts:

• Download TrueType fonts as outlines
• Download TrueType fonts as bitmap
• Substitute with Device fonts

3. Click OK to save the Font Settings. 

True Type Font Options Descriptions
Download TrueType 
fonts as outlines

Sends fonts to the printer system as outline fonts when using 
multiple fonts and font sizes. 

This option decreases the spooler size and can be combined 
with the Disable Device fonts. For further details, refer to the 
next item, Disable Device fonts.

Download TrueType 
fonts as bitmap

A small number of fonts and font sizes can be converted and 
sent to the printer as bitmaps. 

This option increases the spooler size and can be combined 
with the Disable Device fonts. For further details, refer to 
Disable Device fonts described below.

Substitute with Device 
fonts

Unsupported fonts are replaced with built-in fonts by the printer 
without altering the document. 

For further details, refer to the next item, Selecting Fonts for 
Substitution.
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Disable Device fonts

Even if you send the TrueType fonts to the printer as outline fonts or bitmap images, for 
common fonts, the printer substitutes fonts resident on the printer in certain cases.

1. In the Font Settings dialog box, enable the Disable Device fonts check box to prevent 
any substitution of TrueType fonts with built-in printer fonts. 

Selecting Fonts for Substitution  

2. Select your preference for substitution from the Available Device Fonts for each system 
font, and then click OK. 

Options Descriptions
Font Substitution... Determines the fonts that are substituted by the printer.

Substitute with 
Device fonts

Determines which printer fonts are used as substitutions. Select 
Substitute with Device fonts to activate Font Substitution.

Available Device 
Fonts

Displays the available fonts in the Font Substitution dialog box.

The fonts installed on your computer are listed in the System Fonts, 
and the printer fonts are listed in Available Device Fonts.
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Advanced Graphic Settings -- PCL

1. On the Imaging tab, click the Graphics Settings... button. The Graphics Settings dialog 
box appears. 

2. Determine the Options settings. Refer to the options and descriptions below.

3. Click OK to save the settings. 

Options Descriptions
Print Text as Black Prints color and gray characters in black. 

There is no effect on white text, color images, or graphics. 

Print Graphics as Black
(monochrome printers 
only)

Prints color graphics and text in black, without using grayscales. 
There is no effect on images or photographs using the following 
formats:
*.bmp: bitmap 
*.jpg:    joint photographic experts group
*.psd:   portable scheme debugger  
*.tiff:      tagged image file format

This function is enabled in Computer Aided Design (CAD) 
applications only. 
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Detailed Graphics Settings -- KPDL

1. Click the Graphics Settings... button. The Graphics Settings dialog box appears. 

2. Select the send method for images using the Optimization option.

3. Click the Optimization drop-down list and select Fast Printing or Document Portability. 
Refer to the options and descriptions below. 

Image Data Format 
Options

Descriptions

Fast Printing (Recommended) Delivers image data in binary format. You can 
reduce the amount of spooler data and raise printing speed. 

Document Portability Delivers image data in ASCII (7 bit) format.
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4. Determine the Options settings. Refer to the options and descriptions below. 

5. Click OK to save your settings. 

Options Descriptions
Print Text as Black Prints color and gray characters in black. 

There is no effect on white text, color images, or graphics. 

Print Graphics as Black
(monochrome printers 
only)

Prints colored graphics or text in black, without using 
grayscales. There is no effect on images or photographs 
(*.bmp, *.jpg, *.psd, *.tiff). 

This function is enabled in CAD applications only. 

Reverse Image Outputs a reversed black and white negative effect.

Mirror Print Prints a mirror image of the page, with right and left reversed. 
Produces a mirror-like effect. 

Halftone Screen 
(monochrome printers 
only)

By disabling GDI compatible mode check box in the PDL 
Settings, you can enable the halftone screen settings. 

You can adjust the dithering process by changing the number of 
dot lines, angle, and dot shapes. 

Images are divided into dots. As the number of the dot lines 
increases and the interval between the dots grows smaller, the 
image is printed more distinctly. As the number is reduced and 
the interval between the dots is increased the image is printed 
more coarsely. For further details, refer to the next item, Half 
Tone Screen Settings on page 71.
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Half Tone Screen Settings

1. Click Halftone Screen... on the Graphics Settings dialog box. The Halftone Screen 
Settings dialog box appears. 

2. Clear the Use Printer’s Default Screens check box. 

3. Select from the drop-down list for each item, or enter values into the boxes to make 
settings. Refer to the options and descriptions listed below.

4. Click OK to save the settings. 

Options Descriptions
Ink Determines the color used for the printed output.

Frequency Set the number of lines and units for halftone dots. The units are 
lines/cm or lines/inch. Enter a value in the Frequency box, and 
select the units from the drop-down list to the right. 

Angle Determines the halftone dot angle. The setting can range from 
0.0 to 180.0 degrees. 

Shape Set the dot shape for halftones. 
Choose from: Ellipse, Round, and Line.

Use Accurate Screens Fine adjusts the set values to ensure an accurate number of lines 
and halftone angle.
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Adjusting Color You can adjust attributes of text and graphics for your color printouts. 

Color Mode

You can switch between printing in Color (CMYK) and Monochrome modes. Specifying 
Custom mode allows you to select the desired effects including Gray Component 
Replacement, Continuous Tone, Gloss Mode, and Monochrome. Refer to Color Mode 
Definitions table below.

1. From the Print dialog box of the application, access the printer Properties. Select 
Properties in the Print dialog box opened from the File menu.

2. In the Properties dialog box, click the Color tab.

3. Click the Color Mode drop-down list, and make a selection. For further details, refer to 
the table below. 

Color Mode Settings 
Options

Descriptions

Color (CMYK) Uses the four toner colors to print text and graphics in full color.

Monochrome Uses only the black toner for black-and-white printing. 

Custom Opens the Color Mode Settings dialog box. You can adjust the 
settings for gray component replacement, continuous tone, glossy 
mode, and monochrome mode. For further details, refer to Color 
Mode Definitions.
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Color Mode Definitions 

If you specify Custom as the Color Mode in the proceeding step, you can make the Custom 
settings. Detailed settings are available for Gray Component Replacement, Continuous 
Tone, Gloss Mode, and Monochrome options and descriptions shown below. 

1. For the Color Mode, select Custom.

2. Click the [...] button next to drop-down list to display the Color Mode Settings dialog box. 

3. Select the check box for your preferred settings.

4. Click OK. 

Color Mode Setting Item 
Options

Descriptions

Gray Component 
Replacement

Instead of deriving a black color by mixing CMY toners, the 
black toner is used. This conserves CMY toners and improves 
the quality of black printing. 

Continuous Tone Pixels are printed in multiple layers. This mode is best for 
printing photographs. 

Gloss Mode Enhances the luster of printing. Gloss Mode is not supported for 
duplex printing.

Monochrome Converts color data to grayscale for printing. This function can 
be used for a preview before printing in color mode. Gray 
Component Replacement and Continuos Tone cannot be 
used with the monochrome mode. 
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Color Matching

Color Matching is used for greater consistency in color reproduction among various devices. 
It works by compensating for the different color spaces of color printers. A set of parameters 
called a profile is selected and applied. 

The KX printer driver offers a variety of profiles for each simulation of ICM, Monitor and Ink. 
Color matching options are described below. 

1. In the Properties dialog box, click the Color tab.

2. Select for your preferred settings.

Color Correction Options Descriptions
Automatic Color matching is performed based on default color settings. 

For details, refer to Color Reproduction Settings on page 
76.

ICM 
(System Corrected)

Specifies how the color is processed in the print job in order to 
match the original as much as possible. Image Color 
Management (ICM) technology relies upon associating an 
output device like a printer with a Color Profile. An ICM Profile 
for a printer contains information about rendering accurate 
color information for that device. For further details about 
making these settings, refer to the next section, ICM Settings. 

ICM is available in Windows 2000/XP only. 

None 
(Application Corrected)

Color matching is only performed by the application.

Monitor Simulation 
(RGB)

Reproduces the colors in simulation with those displayed on 
the monitor in RGB mode. 

sRGB (HDTV): RGB color matching based on HDTV 
standards.

Ink Simulation
(CMYK)

Select Ink Simulation to display the drop-down list. Specifies 
color matching based on CMYK inks. This option requires that 
the PDL be set to KPDL. For further details, refer to Page 
Description Language (PDL) Settings on page 24. 

Euroscale Press: Simulation based on European offset 
printing standards. SWOP Press: Simulation based on 
American offset printing standards. 
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ICM Settings

You can select an appropriate color reproduction method that agrees with the contents of the 
print data. 

1. Select ICM to display the ICM Settings... button.

2. Choose from the Rendering Intent options listed in the table below. 

3. Click OK to save the ICM Settings.

To make this function effective, set the Color Profile as the default on the Color Management 
tab.

Color Reproduction If Automatic is set for Color Correction, Color 
Reproduction settings can be made. Objects within the 
document being printed are separated into three types; 
images, text, and graphs. The Color Reproduction mode is 
matched for each. Reproduction can be closer to the original 
and more vivid than the colors displayed on the monitor. For 
further details about making these settings, refer to Color 
Reproduction Settings on page 76.

ICM Setting Options Descriptions
Optimize for Exact Color 
(Colormetric)

Utilizes the same color is needed in all print jobs, such as 
business logos.

Optimize for Color Contrast 
(Best for Images)

Utilizes images or scanned photographs containing many 
colors or shades of color.

Optimize for Color 
Saturation (Best for Graphs)

Utilizes graphs or charts containing solid colors.

Color Correction Options Descriptions
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Color Reproduction Settings

Objects within the document being printed are separated into three types, images, text, and 
graphs, and the Color Reproduction mode is matched for each.

1. Select Automatic in the Color Correction group box, then click the Color Reproduction 
button. 

2. The Color Reproduction dialog box appears. Select one of the items under Mode. Click 
OK to save the color reproduction settings. 

Mode Options Descriptions
Auto 1 This is the most commonly used standard mode. 

Auto 2 • Text and graphs are printed in black. 
• Images are printed in colors close to those used in the monitor 

display.
• Text and graphics are printed in vivid colors. 

Auto 3 • Text and graphs are printed in black using four color toners 
(CMYK). 

• Images are printed in colors close to those used in the monitor 
display.

• Text and graphics are printed in vivid colors. 

Auto 4 • Images and graphs are printed in colors close to those used in 
the monitor display.

• Text and graphics are printed in vivid colors. 

Picture Image Images, text, and graphs are printed in colors that are close to 
those shown on the monitor. This is the optimal mode for printing 
photographs. 

Text Print all objects written in black using black toner only. All objects 
are printed in vivid colors. 

Chart (Graphics) Print all objects, including those written in black, using four color 
toners (CMYK). All objects are printed in vivid colors. 
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Color Adjustment Settings -- HSL

You can save the three Color Adjustment settings as a Custom selection. The setting 
options and saving instructions are described below.

1. From the Color Adjustment drop-down list, choose Custom 1, Custom 2, or Custom 3. 

2. Click the [...] button next to the drop-down list to display the Color Adjustment dialog 
box.

3. In the Color Space group box, select HSL (Hue, Saturation, Lightness).

Color Space Option Description
HSL (Hue, Saturation, and 
Lightness)

Offers adjustment of hue, color intensity, brightness, and 
contrast.
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4. By clicking the buttons beneath the photograph, you can select from three different 
photographic images. 

Since the colors emphasized by each of the photographs are different, this simplifies the 
color adjustment process. 

5. Complete the Hue Adjustment. Adjust the distribution and balance of hues. 

• Coordinated Hue Adjustment: Select Master from the Hue Adjustment drop-down 
list. Drag the slider to the right or left to increase or decrease the value between 
-180 and +180.

• Specific Hue Adjustment: Select Red, Yellow, Green, Cyan, Blue, or Magenta 
from the Hue Adjustment drop-down list. Or drag the slider to the right or left to 
increase or decrease the values between -10 and +10. 

• Default settings: Click the Reset button to return to the original factory default 
settings. 

Saturation or RGB 
adjustment

Skin tone and mid-tone 
adjustment

Hue adjustment
Crayons Portrait Fruits
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6. Adjust the Saturation and Lightness.

• Drag the slider to adjust the Saturation, Lightness, and Contrast, or increase or 
decrease the values between -10 and +10.

• Click the Reset button to return to the original factory default settings.

7. Click OK. 

8. Click OK to save the settings.
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Color Adjustment Settings -- RGB

You can save the three Color Adjustment settings as a Custom selection. The setting 
options and saving instructions are described below.

1. From the Color Adjustment drop-down list, choose Custom 1, Custom 2, or Custom 3.

2. Click the [...] button next to the drop-down list to display the Color Adjustment dialog 
box.

3. In Color Space, select RGB mode.

Color Space Option Description
RGB Adjusts using red, green, and blue levels. 



Printing from Applications

81

4. By clicking the buttons beneath the photograph, you can select from three different 
photographic images. 

The color adjustment process is simplified since the colors emphasized by each of the 
photographs below varies. 

5. Adjust the RGB Level. 

• You can modify the levels of red, green, and blue based on the monitor settings. 
• Drag each slider of the RGB setting, or increase or decrease the values between -10 

and +10 in the spin box.
• Click the Reset button to restore the original default settings.

6. Click OK to save the color adjustment settings. 

7. Click OK.

Saturation or RGB 
Adjustment

Skin tone and mid-tone 
Adjustment

Hue Adjustment
Crayons Portrait Fruits
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4. Useful Functions

This section describes useful functions of the printer driver.

The properties boxes described here may differ from those for your printer. 

Staple The Staple feature is available on printers with an optional finisher installed. If a booklet 
stitcher unit is installed, the Booklet Printing feature is available. For further details, refer to 
Booklet Printing on page 99.

After installation, optional equipment must be selected by the printer driver (device settings). 
For further details, refer to Installing Optional Devices on page 17.

Printed documents can be stapled in the positions shown below.

Staple and Offset features cannot be used simultaneously. 

Upper Left Upper Right Booklet
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Using the Stapler

When the paper size is A4, B5, or Letter, the Orientation must be set to Rotated in order to 
staple the upper-right corner. For further details, see the explanation on page 40 in step 8 in 
the Basic Printing Tasks section.

1. From the application’s Print dialog box, access Properties. (Select Print from the File 
menu and select Properties).

2. On the Output tab, select Finisher (Face-down) from the Output to drop-down list. 

3. Select the Staple check box in the Finishing Options group box. Select one of the 
following as the stapling position: Upper Left, Upper Right, or Booklet. 
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4. Click the [...] button on the right of the stapling position. The Staple Settings dialog box 
appears. Specify the number of pages to staple by adjusting the arrows in the Staple 
Count group box. 

• All Sheets (maximum of 50): Staples and outputs all pages of documents that have 
50 pages or less. If the document being printed has 51 or more pages, it cannot be 
stapled. For example, If the document being printed has 58 pages, it cannot be 
stapled. 

• After every sheet(s): Parameter separates documents into sets with a specific 
number of pages, then staples and outputs them. You can designate from 2 to 50 
pages in each stapled set. Even if there are fewer than the specified number of 
pages, the document will be stapled. For example, if stapling has been specified for 
every 50 pages and a document is printed that has a total of 58 pages, the print job 
will be split into two separate stapled sets of 50 and 8 pages. 

5. Click OK to return to the Print dialog box, and click OK to start printing. 

The final printed document is stapled by the finisher and delivered to the output tray. For 
further details about stapler specifications, refer to your supplied finisher Operation Guide.
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Offset The Offset stacks each printed document by shifting from right to left as it is delivered to the 
output tray. 

Offset is available on printers with a supported finisher (optional) installed. 

After installation, optional equipment must be recognized by the printer driver (device 
settings). For further details, refer to Installing Optional Devices on page 17.

Offset and Staple cannot be used simultaneously.

Using the Offset

1. From the application’s Print dialog box, specify the number of copies of the document to 
be printed. 

2. Click Properties in the Print dialog box. The Properties dialog box appears.

3. Click the Output tab in the Properties dialog box.

4. Set either Finisher (Face-down) or Finisher (Face-up) as the output destination, then 
enable the Offset check box in the Finishing Options section.

5. Click OK to return to the Print dialog box, and click OK to start printing. 

After the first set is delivered, the second set will be delivered offset to the side. Then the 
printer delivers the third set in the same position as the first and the fourth set in the same 
position as the second. 

Output direction
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Punch The Punch feature inserts holes (two holes) in each printed page.

The Punch feature is available on printers with supported optional finisher installed.

After installing the printer driver, optional equipment must be selected in the driver in order to 
use the punch option (device settings). For further details, refer to Installing Optional 
Devices on page 17.

Punch and Booklet Printing cannot be used simultaneously.

Using the Punch

1. In the Properties dialog box, click the Output tab.

2. Select either Finisher (Face-down) or Finisher (Face-up) as Output destination.

3. Select the Punch check box in the Finishing Options section, and select the number of 
holes.

4. Click OK to return to the Print dialog box, and click OK to begin printing. 

Holes are punched in each printed page.
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Cover Mode, 
Page Insert, and 
Transparency 
Interleaving This section describes the cover mode, page insert, and transparency interleaving features of 

the printer driver. When the Cover Mode, Page Insert, and Transparency Interleaving options 
are used with the multi-purpose tray, cassette mode (the default setting), must be set. For 
further details, refer to the print system's Operation Guide.

• Cover Mode: Adds a front or back cover to your document. 
• Page Insert: Inserts blank or printed pages before pages in your document. 
• Transparency Interleaving: Inserts a blank or printed page between each 

transparency.

Printing with Covers

For your document's front cover or front and back covers, you can insert and print on paper 
that is heavier or a different color than the paper for the body of the document. You can also 
specify cover printing when completing booklet printing settings. The paper used for printing 
the document body is specified in the Media settings of the Properties dialog box. The 
source of the cover paper is specified by adjusting settings in the Advanced Media Settings 
dialog box. You can also print on the covers. 

A duplexer must be connected in order to print using the Front Inside or Front Outside. You 
must also specify Print on Both Sides (Duplex) on the Layout tab. 

Although the Cover Mode and Page Insert may be used simultaneously, they cannot be 
used with the Transparency Interleaving option.

For further details on printing with covers in the booklet printing settings, refer to Booklet 
Printing on page 99.

Printing with Covers

1. From the application’s Print dialog box, access the printer Properties. Select Print from 
the File menu and select Properties.

2. In the Properties dialog box, click the Media tab, and then click Advanced....



Useful Functions

89

3. Select the Cover Mode check box. Select your desired page arrangement as shown in 
the following table. 
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Cover Printing Options

Check Box Selection Cover Insertion Type
Front • Inserts a blank front cover.

Front
Front Outside

• Prints on the outside surface of the front cover.

Front 
Front Inside

Duplex Printing (page 50).

• Prints on the inside surface of the front cover.

Front 
Print Onto Front Outside
Print Onto Front Inside

Duplex Printing (page 50).

• Prints on the outside and inside surfaces of the front 
cover.

Front and Back • Inserts blank front and back covers.

Front 
cover

Front 
cover

Front 
cover

Front 
cover

Front 
cover

Back
cover
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Front and Back
Front Outside

• Prints on the outside surface of the front cover and 
inserts a blank back cover.

Front and Back
Front Inside

Duplex Printing (page 50).

• Prints on the inside surface of the front cover and 
inserts a blank back cover.

Front and Back
Front Outside
Front Inside

Duplex Printing (page 50).

• Prints on both sides of the front cover and inserts a 
blank back cover.

Front and Back
Back Inside

• Inserts blank front and back covers.

Front and Back
Back Outside

Duplex Printing (page 50).

• Prints on the outside surface of the front cover and 
inserts a blank back cover.

Check Box Selection Cover Insertion Type

Front 
cover

Back
cover

Front 
cover

Back 
cover

Front 
cover

Back 
cover

Front 
cover

Back 
cover

Back 
cover

Front 
cover



92

4. From the Media for Cover drop-down list, select the media type or source cassette for 
the front and back covers. When you choose the media type, a source cassette matching 
that media is automatically selected. 

Heavy, thin, or other special papers must be supplied from the multi-purpose tray. 

Media type selections are not supported for the following models: 
KM-1510, KM-1530, KM-1810, KM04230, KM-5230, and KM-6230.

5. Click OK to return to the Media dialog box.

6. Load the paper for the front and back cover in the paper cassette selected in step 4. 

7. Click OK to return to the Print dialog box

Front and Back
Back Inside
Back Outside

Duplex Printing (page 50).

• Prints on the inside surface of the front cover and 
inserts a blank back cover.

Front and Back
Front Outside
Front Inside
Back Inside
Back Outside

Duplex Printing (page 50).

• Prints on both sides of the front cover and inserts a 
blank back cover.

Check Box Selection Cover Insertion Type

Front 
cover

Back 
cover

Back 
cover

Front 
cover
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8. Click OK to start printing. 

Page Insert

You can insert a preprinted page or a page of a different paper type before a designated 
page. You can also print on the inserted paper. If a duplexer unit is installed, you can also 
print on the reverse of the inserted paper. 

Although the Page Insert and Cover mode may be used simultaneously, they cannot be 
combined with the Transparency Interleaving described in Transparency Interleaving on 
page 96.

Insert Page Printing

1. From the application’s Print dialog box, access the printer Properties. (Select Print from 
the File menu and select Properties).

2. In the Properties dialog box, click the Media tab, and then click Advanced....
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3. Select the Page Insert check box. Select the check box corresponding to your desired 
page arrangement as shown in the following table. To print on both the front and back of 
the inserted page, enable the Print onto Front and Print onto Back check boxes.
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Insert Page Combinations

4. Enter the page number to insert. A page will be inserted between the page number you 
entered and the page before it. You can designate for pages to be inserted starting from 
page 2 and ending on page 255.  

To designate several pages in the document for insertion, enter a comma (,) to separate 
them. For a series of insertions in a range of pages, use a hyphen (-). For example, to 
insert a page before pages 5, 11, 12, 13, and 18, enter [ 5,11-13,18 ].

Check Box Options Printing Inserted Pages Descriptions
Page Insert • Inserts a blank page before the second page.

Page Insert
Print onto Front

• Prints on the outside surface of the inserted page.

Page Insert
Print onto Back

Duplex Printing (page 50).

• Prints on the inside surface of the inserted page.

Page Insert
Print onto Front
Print onto Back

Duplex Printing (page 50).

• Prints on both sides of the inserted page.

Inserted 
page

Inserted 
page

Inserted 
page

Inserted 
page
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5. From the Media for Page drop-down list, select the media type of the inserted page or the 
source paper cassette.

When you choose the media type, a source cassette that matches that media is 
automatically selected. Heavy, thin, or other special papers must be supplied from the 
multi-purpose tray. 

6. Click OK to return to the Media dialog box. 

7. Click OK to return to the Print dialog box.

8. Load the paper for insertion in the paper cassette.

9. Click OK and begin printing. 

Transparency Interleaving

By inserting a page between each sheet of paper, you can avoid damaging the 
transparencies, inserting a sheet of paper between them. This function is only available when 
printing transparencies supplied from the multi-purpose tray. On these inserted pages you 
can print the same content as for the transparencies.

Transparency interleaving and Cover Mode or Page Insert cannot be used 
simultaneously.
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Transparency Interleaving Method

1. From the application’s Print dialog box, access the printer Properties. Select Print from 
the File menu and select Properties.

2. From the Source drop-down list on the Media tab, select Multi-Purpose Feeder.

3. From the Media Type drop-down list, select Transparency.
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4. Click Advanced... to access the Advanced Media Settings dialog box. 

5. Select the Transparency Interleaving check box. To print the transparency content on 
the inserted pages as well, Select the Print onto Backing check box.

6. From the Media for Backing drop-down list, select the media type and the source paper 
cassette. When you choose the media type, the source cassette where that media is 
loaded will be automatically selected.

7. Click OK to return to the Media dialog box. 

8. Click OK to return to the Print dialog box.

9. Load transparency into the multi-purpose tray.

10.Click OK and begin printing.
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Booklet Printing Using the Booklet Printing option, you can print a two-page layout on both sides of single 
sheet of paper, then bind it in the center. Booklet printing is available with printers equipped 
with duplexers. Stapling and binding requires optional document finishers. For further details 
on Staple settings, refer to Staple on page 83.

The supported paper sizes for Booklet Mode printing are A3, ledger, B4, A4, and letter size. 
The Booklet Printing can be combined with the Cover Mode. For further details, refer to 
Printing with Covers on page 88.

Left-Edge and Right-Edge Binding

Printing a four-page document as a booklet, for example, will result in automatic duplex 
printing shown below. You can choose between left-edge binding and right-edge binding.

Using Booklet Printing

1. From the application’s Print dialog box, access the printer Properties. (Select Print from 
the File menu and select Properties.)

2. Access the printer Properties and click the Layout tab.

Left Edge Binding

Outside

Inside

Outside
Outside

Inside

Outside

Inside

Outside

Outside

Inside

ght Edge Binding
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3. Select the Booklet Mode check box. Choose either Left Edge Binding or Right Edge 
Binding. 

Complete the following steps to utilize the stapling feature.

4. Click the Output tab, and set Finisher (Face-down) for Output to.

5. Select the number of copies you wish to print.

6. Select the Staple check box. Booklet (Fold) printing is selected automatically. 

Click the [...] button to the right of the list and set the number of sheets to staple together. 
The maximum number of sheets that can be stapled with booklet mode is 10 (40 pages). 
When printing documents that have more than 40 pages, the pages over 40 will be 
separated and printed in groups of 40 each. 

7. Click OK to return to the Print dialog box.

8. Click OK to start printing. 
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Collating Modes By attaching a sorter to your printer, you can specify how printed documents are stacked in 
the output trays after printing.

The number of output trays and their receiving capacity (the number of sheets) varies 
depending on the sorter model, refer to your sorter's Operation Guide.

Frequently, the application settings are given priority, causing a change in the sorter output 
method depending on the application. Verify these settings before printing your documents.

Sorter Modes

There are three sorter modes to choose from. These modes are selected on the printer driver 
Output tab: 

• Collating mode

• Non-collating mode

• Mailbox mode
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Sorter Mode Differences

Collating • Collating produces the specified number of 
copies as complete sets of documents in 
each tray.

• The document is printed following the page 
order and received in each tray. The number 
of document copies must not exceed the 
number of trays. If a tray becomes full, the 
printer pauses and displays a message to 
remove the paper from the tray. After the 
paper is removed, printing resumes for the 
remaining number of copies.

• This function requires a hard disk installed in 
the printer or a RAM disk. For setup 
information, refer to RAM Disk Settings on 
page 20.

Non-collating • Collating produces the specified number of 
copies but divides the document for output in 
each tray, with page 1 in tray 1, page 2 in tray 
2, and so on. For example, printing 20 copies 
of a four page document using grouping 
produces 20 copies of page 1 in tray 1, 20 
copies of page 2 in tray 2, and so on.

• The number of document copies must not 
exceed the sheet capacity of any tray. If a 
tray becomes full, the printer pauses and 
displays a message to remove the paper 
from the tray. In addition, the maximum 
document page length must not exceed the 
number of sorter trays. If a tray becomes full, 
the printer pauses and displays a message 
to remove the paper from the tray.

Mailbox • The mailbox mode produces copies in 
specified user trays, which is useful when 
the printer is shared among different users. 
For example, specifying tray 5 produces a 
copy of the document in tray 5.

• If a tray becomes full, the printer pauses and 
displays a message to remove the paper 
from the tray.

Tray 1
Tray 2
Tray 3
Tray 4
Tray 5

Page 1
Page 2 Page 2 Page 2

Page 1 Page 1

20 copies of 

20 copies of 

Tray 1
Tray 2
Tray 3
Tray 4
Tray 5

Page 1
Page 1 Page 2

Page 2
Page 3

Page 3

Tray 1
Tray 2
Tray 3
Tray 4
Tray 5
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Collating

1. Access the Properties and click the Output tab.

2. From the Output to drop-down list, select Mailbox Face-down. 

3. Select the Collate check box.

4. Select the number of complete sets in the Copies combo box. When printing using the 
collate option, specify the number of copies not to exceed the number of trays. The 
document page length must not exceed the tray capacity (for example, 200 sheets).

5. Click OK to return to the Print dialog box, and click OK to begin printing. The specified 
number of copies are produced in separate trays.
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Non-Collating

Clearing the Collate check box produces page 1 in tray 1 and page 2 in tray 2.

1. Access the Properties and click the Output tab.

2. From the Output to drop-down list, select Mailbox Face-down.

3. Clear the Collate check box. 

Click OK to return to the application’s Print dialog box and begin printing. The specified 
number of copies of each page of the document are delivered to each tray.

Mailbox Mode

1. From the Output to drop-down list, select Mailbox Face-down.

2. Select the Mailbox check box. Select the desired output tray to be used (for example 
Mailbox 1) from the drop-down list at right.

3. Click OK to return to the Print dialog box, and click OK to start printing. The document is 
delivered to the specified tray, (for example Mailbox 1).
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Rotate Collate The Rotate Collate stacks the sets produced in the top tray in alternating orientations.

This function is available when printing using A4, B5, and letter size paper. During printing, 
the same size paper must be loaded into two separate paper cassettes. For example, Portrait 
(A4) and Landscape (A4-R) would be used when printing onto A4 paper. The MP tray can 
also be used as a paper source. 

This function requires a hard disk installed in the printer or a RAM Disk. For further details on 
Hard Disk settings, refer to RAM Disk Settings on page 20.

Using Rotate Collate

1. Access the Properties and click the Output tab.

2. From the Output to drop-down list, select Top Tray (Face-down).

3. Enter the number of sets to be output in the Copies combo box. The number of pages for 
all copies of the document being printed must not exceed the tray capacity.

4. Select the Collate and Rotate Collate check boxes.

5. Click OK to return to the Print dialog box, and click OK to start printing. The collated 
document sets are delivered in alternating horizontal and vertical orientation.
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Job Settings The Job Settings option is available when you install an optional hard disk on the printer. For 
further details on hard disk installation and setup, refer to RAM Disk Settings on page 20. 
Private print and Proof and Hold can be used with a RAM disk.

Job Settings offers a variety of functions as listed below.

• Sometimes the application settings are given priority over the printer driver settings, 
causing a change in the output method.

• If you select one of the Job Setting options, the hard disk icon displays in the lower corner 
of the 3-D image.

Printer Driver Menu 
Options

Function Job Deletion after 
Printing

Access Code Panel Message
(Category)

Default number 
of pages printed

Quick Copy After printing a job, you 
can reprint it from the 
printer operator panel.

Saved until 
printer power is 
turned off

No Menu> e-MPS 
>Quick Copy

Same as for 
original job 
(adjustable)

Proof and Hold When you print multiple 
copies, the printer 
produces one copy for 
proofing and pauses. 
You can resume printing 
the remaining copies 
from the printer operator 
panel.

Saved until 
printer power is 
turned off

No Menu> e-MPS 
>Quick Copy

One fewer than 
original job 
(adjustable)

Private Print Saves print jobs (without 
printing them) for 
printing later using the 
printer operator panel. 
Printing with this function 
requires an access 
code.

Deleted after 
printing

Yes Menu> e-MPS > 
Private/Stored

Same as for 
original job 
(adjustable)

Job Storage This function is used for 
saving frequently used 
office forms to print later 
as needed.You can print 
the required number of 
copies later from the 
printer operator panel.

Saved until 
manually deleted

Optional Menu> e-MPS > 
Private/Stored

1
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Quick Copy

After using the quick copy feature, a document can be reprinted from the operator panel.

1. In the Properties dialog box, click the Output tab, and then click Job Settings. The Job 
Settings dialog box appears.

2. In the Job Settings dialog box, enable the Job Storage (e-MPS) check box. For Quick 
Copy printing, select Quick Copy.

3. You can name the job for later reference when printing from the print operator panel. In 
Job Name, select Application Defined for automatic naming by the application. Or, 
select Custom to enter a name of your choice. The name can be up to 31 characters.

4. Click OK.

When you print from the application, the job will be saved to the hard disk while the 
specified number of copies prints.

For further details on printing additional copies of a Quick Copy job, refer to Printing 
Additional Copies of Quick Copy Jobs on page 108.
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Printing Additional Copies of Quick Copy Jobs

The actual key operation may differ depending on the model.

1. Press the MENU key on the printer operator panel.

2. Press the  or  key repeatedly until e-MPS > appears.

3. Press the  key to access the submenu. 

4. Press the  or  key repeatedly until >Quick Copy appears. 

5. Press the ENTER key. A blinking question mark [ ? ] displays by the user name.

6. If the user name is correct, press the ENTER key. Otherwise, press the  or  key until 
the correct name appears.

7. Press the ENTER key. Follow the instructions in the Identification on page 22 to 
continue.

8. The job name appears with a blinking question mark [ ? ].
If this is the correct job for printing, press the ENTER key.

Otherwise, press the  or  key until the correct name appears. Then, press the 
ENTER key.

9. Press the  or  key to specify the number of copies.

10. Press the ENTER key. The Quick Copy job initially printed is printed in the specified 
number of copies.

Deleting Quick Copy Jobs

1. Refer to steps 1 through 8 in Printing Additional Copies of Quick Copy Jobs on page 
108. 

2. If this is the correct job for deletion, press the ENTER key.

Otherwise, press the  or  key until the correct name appears.

3. After the menu for specifying the number of print copies appears, press the  key once. 
Delete appears.

4. Press the ENTER key to delete the job.
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Proof and Hold

1. Access the Job Settings dialog box as indicated in the instructions for Quick Copy on 
page 107. Select Proof and Hold.

2. Name the job for future reference when printing from the print operator panel.

• If you select Application Defined in Job Name, the application automatically names 
the document.

• In the Job Name group box, select Custom to enter a name of your choice. The 
name can be up to 31 characters in length.

Click OK. When printing a Proof and Hold job of multiple copies, only the first copy is printed 
and the remaining copies are saved. Follow the steps below after proofing the first copy.

Printing the Remaining Copies of Proof and Hold Jobs

You can print the remaining copies of Proof and Hold jobs following the same steps as for 
Printing Additional Copies of Quick Copy Jobs on page 108. Use the keys on the printer 
operator panel to proceed. When using the Proof and Hold option, the number of copies 
displayed will be one less than the total due to the existing proof copy. The printed jobs will 
remain saved on the hard disk until the printer is turned off. To delete jobs manually, use the 
same key operations as explained in Deleting Quick Copy Jobs on page 108.
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Private Print

Private Print jobs are saved to the hard disk for printing until a four-digit access code is 
entered.

The saved jobs are deleted as soon as they are printed. To print using Private Print, follow 
these steps:

1. Access the Job Settings dialog box as indicated in the instructions for Quick Copy on 
page 107. Select Private Print.

2. Enter four digits with any numbers between 0 and 9 for the Access Code. 
When you want to print a saved job, enter the access code on the printer operator panel.

3. You can name the job for later reference when printing from the print operator panel.

• If you select Application Defined in Job Name the application automatically names 
the document.

• In Job Name, select Custom to enter a name of your choice. The name can be up to 
31 characters in length.

4. Click OK.
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Printing Private Print Jobs

The actual key operation may differ depending on the printer model.

1. On the printer operation panel, press the MENU key.

2. Press the  or  key repeatedly until e-MPS > appears.

3. Press the  key to access the submenu.

4. Press the  or  key repeatedly until >Private/Stored appears.

5. Press the ENTER key, the user name displays with a blinking question mark [ ? ].

6. If the user name is correct, press the ENTER key. Otherwise, press the  or  key until 
the correct name is displayed.

7. The job name is displayed with a blinking question mark [ ? ]. Press the ENTER key.

8. The user name displayed is specified following the instructions in the Identification on 
page 22. If this is the correct job for printing, press the ENTER key.

Otherwise, press the  or  key until the correct job name appears, then press the 
ENTER key.

9. Enter the four-digit access code created in Private Print on page 110. 

10. Press the or  key to increase or decrease the number. 

11.Press the  or  key to move the cursor right and left.

12. Press the ENTER key. Use the  or  key to specify the number of copies for printing.

13. Press the ENTER key to start printing.

After printing, the job will be automatically deleted from the hard disk. To delete the job 
without printing it, follow the same procedure as in Deleting Quick Copy Jobs on page 
108.
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Job Storage

The Job Storage feature saves jobs on the hard disk for future printing, even if the printer is 
switched off. You can also use access codes to restrict the printing of forms.

1. Access the Job Settings dialog box as indicated in the instructions for Quick Copy on 
page 107. Select Job Storage.

2. Select the Access Code check box and enter the desired four-digit access code using 
numbers between 0 and 9. When you want to print the saved jobs, enter the access code 
on the print operator panel.

3. You can name the job for future reference when printing from the print operator panel.

• If you select Application Defined in the Job Name field, the application 
automatically names the document.

• In Job Name, select Custom to enter the name of your choice. The name can be up 
to 31 characters in length.

4. Click OK. When you select print, the job will be saved to the hard disk without printing.

Printing Jobs Saved Using Job Storage

To print forms and other documents saved using Job Storage, follow the same steps as for 
Printing Private Print Jobs on page 111.

The stored jobs will remain saved even after the printer is switched off. To delete them 
manually, follow the same steps as for Deleting Quick Copy Jobs on page 108. When 
deleting jobs, you must enter the same access code as saved in the Job Storage procedure.
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Virtual Mailbox

With the Virtual Mailbox feature, mailboxes created on the hard disk are assigned to multiple 
users. Jobs posted to a virtual mailbox can be printed later from the printer operator panel. 
Jobs saved in virtual mailboxes are automatically deleted after printing and jobs that have not 
been printed are saved if the printer is switched off. You must create and setup your virtual 
mailboxes prior to utilizing this feature.

The Virtual Mailbox feature is available when the printer is set to emulate HP PCL 5e, PCL 
XL, or PCL 5c. For information on emulation settings, refer to Page Description Language 
(PDL) Settings on page 24.

Create a virtual mailbox by specifying a mailbox name and number. The figure below 
illustrates the virtual mailbox option. For further details, refer to Creating Virtual Mailboxes 
on page 114.

• You can group multiple mailboxes and identify the group with a unique name. You can save 
jobs into multiple mailboxes, or save it into all the mailboxes at the same time. 

• Up to 255 mailboxes can be created. The total mailbox capacity varies depending on the 
printer model and the size of the hard disk installed. For example, an ECOSYS FS-1800 
printer with a 1 GB microdrive offers an initial mailbox capacity of 50 MB. For further details 
on virtual mailbox capacities of each model, refer to the printer’s Operation Guide.

Resort development

Sales department

Use the printer driver to 
select a virtual mailbox for 
saving a job.

Examination department

Mailbox 1

Mailbox 2

Mailbox 3

Mailbox 4

Mailbox 5
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The following sections explain how to utilize the virtual mailbox option:

• Creating Virtual Mailboxes
• Importing and Exporting the Virtual Mailbox List
• Saving Jobs in Virtual Mailboxes
• Printing Virtual Mailbox Job Lists
• Printing Jobs in Virtual Mailboxes

Creating Virtual Mailboxes

1. Click Start in the Windows taskbar, and click Printers and Faxes to open the Printer and 
Fax window.

2. Right-click the icon for your printer in the Printers and Faxes window. A drop-down list 
appears.

3. Click Properties in the drop-down list. The Properties dialog box appears. Click the 
Device Settings tab.

4. Select the Hard Disk check box. The Hard Disk Settings dialog box appears. 

5. Click New and enter any name into Mailbox Name.

For example, name the mailbox after the user or department.
The name can be up to 31 characters in length.
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6. The mailbox names appear in the Defined Names list at right.

7. Enter a number between 1 and 255 for the Mailbox Number.

You can enter commas and hyphens to organize multiple mailboxes for the same user. In 
the following example, when the numbers 1, 3, 6, 8-12 are entered, mailboxes 1, 3, 6, 8, 
9, 10, 11, and 12 will be assigned to the name specified in Mailbox Name. Print jobs are 
saved in those boxes simultaneously. 

To assign multiple mailboxes, repeat the above steps. When finished, click OK to close the 
Hard Disk Settings dialog box.

• It is also possible to assign mailboxes using the same mailbox numbers for users with 
different names. However, be aware that this will result in shared mailboxes.

• To delete a mailbox that you created, select the mailbox from the Defined Names list and 
click Delete.
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Importing and Exporting the Virtual Mailbox List

This section explains how to import and export your virtual mailbox lists. You can save the list 
of virtual mailboxes created in the previous section onto your personal computer. Once 
saved, the list can be read by other printer drivers. 

1. Follow the instructions in the previous section to display the Hard Disk Settings of the 
printer driver that will be the source of the list. Click the Export... button.

2. The Export VMB List dialog box appears. Select save location from the Save in drop-
down list. 

3. Enter a name in the File name field and click Save. Close the Properties dialog box.

4. Click Import... to display the Hard Disk Settings of the printer driver that are the 
destination for the list.
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5. The Import VMB List dialog box appears. Select the virtual mailbox data file you wish to 
read from the Look in drop-down list.

6. Click the virtual mailbox list name and click Open.

7. The virtual mailbox list is opened and displayed in the Defined Names group box. Click 
OK to save the list. 
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Saving Jobs in Virtual Mailboxes

1. From the application’s Print dialog box, access the Properties. Select Print from the File 
menu and select Properties.

2. Open the Properties dialog box, and click the Output tab.

3. Click the Job Settings... button to open the Job Settings dialog box.

4. Select the Job Storage (e-MPS) check box.

5. Select Virtual Mail Box VMB and click Selection....

If the Virtual Mail Box VMB button is inactive, no virtual mailboxes have been created yet. 
Click Cancel in the screen above, and create a virtual mailbox while referring to RAM Disk 
Settings on page 20.

6. The Virtual Mailbox Selection dialog box appears. Select the mailboxes for saving the 
job, and click OK.

Close the Properties dialog box. The job is saved to the virtual mailbox on the hard disk and 
held for printing.

• Printing the list -- Refer to the next section, Printing Virtual Mailbox Job Lists on 
page 119. 

• Printing saved jobs -- Refer to Printing Jobs in Virtual Mailboxes on page 120.
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Printing Virtual Mailbox Job Lists

Follow these steps to print the jobs lists of virtual mailboxes. You can print a list if there is at 
least one job saved in the virtual mailbox. In addition, you can print a list of jobs saved in 
virtual mailboxes as a Virtual Mailbox List. 

The list is printed from the printer operator panel.

1. On the printer operator panel, press the MENU key.

2. Press the  or  key repeatedly until e-MPS > is displayed.

3. Press the  key to access the submenu.

4. Press the  or  key repeatedly until >List of VMB appears. 
This menu is not displayed if all virtual mailboxes are empty.

5. Press the ENTER key. A blinking question mark [ ? ] appears.

6. Press the ENTER key again. The list will be printed.

The job list information shows the number of saved jobs, number of pages, size, and other 
specific details for each virtual mailbox. The symbol  to the left of a virtual mailbox 
indicates jobs in the mailbox.

          Virtual Mailbox Job List
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Printing Jobs in Virtual Mailboxes

Jobs are printed from the printer's operator panel.

1. On the printer operator panel, press the MENU key.

2. Press the  or  key repeatedly until e-MPS > appears.

3. Press the  key to access the submenu. 

4. Press the  or  key repeatedly until the display looks like the example shown below. 
This menu is not available if all virtual mailboxes are empty.

         Tray 001: Represents Virtual Mailbox 1.

5. Press the ENTER key. A blinking question mark [ ? ] is displayed.

At this point, if there are jobs in other virtual mailboxes, you can select them (Tray...) by 
pressing the  or  key.

6. To print the jobs in those virtual mailboxes, press the ENTER key.

All jobs in the virtual mailboxes are printed. Once printed, the jobs are automatically deleted 
from the virtual mailboxes.

>Print VMB Data
Tray 001:
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Temporary and 
Permanent Jobs

Functions for jobs saved as Temporary and Permanent jobs are similar to the functions for 
Quick Copy and other features described in Job Settings on page 106. However, these 
functions are provided for backward compatibility with printing environments developed 
before the Job Option. Similar to job options, temporary and permanent jobs use electronic 
sorting for faster printing of jobs with multiple copies. 

The features are listed below:

• Jobs are managed internally with job IDs and printed after saving by an application 
(KM-NETJob Manager).

• Barcode Print Output is supported and facilitates future printing with an optional 
barcode reader. 

• Both types of jobs are saved on the hard disk, up to the user-defined capacity. 
However, temporary jobs are automatically deleted if the defined capacity is reached. 
Permanent jobs remain saved until removed by the user. 
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Printing and Saving Temporary and Permanent Jobs

Check that your printer has an optional hard disk installed. For further details on hard disk 
settings, refer to RAM Disk Settings on page 20.

1. From the application’s Print dialog box, access the Properties. (Select Print from the 
File menu).

2. Open the Properties dialog box, and click the Output tab.

3. Click Job Settings... to access the Job Settings dialog box.

4. Select the Job Storage (e-MPS) check box. Select Temporary or Permanent.

5. When printing a job with a job ID barcode, open the Barcode Option dialog box and 
make the appropriate settings.

For further details, refer to Using the Barcode Reader to Print Additional Copies of Saved 
Jobs on page 125.

Click OK to return to the Print dialog box. While printing, the job will be simultaneously saved 
on the hard disk as either a temporary or permanent job.

To reprint temporary or permanent jobs, the dedicated KM-NET Job Manager utility is 
required. For further details, refer to Using KM-NET for Clients to Print Saved Jobs Again 
on page 123.
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Using KM-NET for Clients to Print Saved Jobs Again

To print out jobs, the KM-NET for Clients utility must first be installed on your computer. The 
utility is located on the supplied Kyocera Software Library CD-ROM. 

The KM-NET for Clients communicates with the printer using TCP/IP protocol. To make a 
local connection with your computer, the KX printer driver must be installed on it.  

1. From the CD-ROM Main Menu dialog box, select Printer Utilities, then KM-NET for 
Clients to install the software.

After installation, follow these steps to launch the KM-NET Job Manager utility:

2. Click Start in the Windows taskbar and All Programs.
Windows 95/98/Me: Click Programs, KYOCERA, and then KM-NET for Clients.

3. Click Add. Depending on your printer connections, select either the Local printer (for 
Parallel Connection) or Network printer.

4. Follow the wizard through the Starting Add Printing System Wizard dialog box. 
Available printers are displayed.
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5. Select the printer to connect and click Finish to return to the main dialog box of the KM-
NET for Clients.

6. Select the printer icon displayed in the main dialog box and click Job Manager. 
Print jobs saved in the printer are displayed.

7. Right-click on the job name and select Print from the drop-down list to print a saved job. 
You can also select multiple jobs for printing simultaneously.

To select multiple jobs, click the jobs while holding down the Ctrl key. Saved jobs are stored 
on the hard disk. 

To delete jobs manually, right-click on the job name and select Delete from the drop-down 
list. For further details, refer to KM-NET for Clients Operation Guide.
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Using the Barcode Reader to Print Additional Copies of Saved Jobs

You can reprint saved print jobs using the optional barcode reader. Use the printer’s serial 
interface to connect the barcode reader to the printer.

When initially printing a job, follow the steps below to print a barcode representing the job ID 
on each page or on the cover page only.

By simply reading the barcode with the barcode reader, you can reprint either a page or the 
entire job.

Printing the Job ID using the barcode reader

1. From the application’s Print dialog box, access the Properties. (Select Print from the 
File menu).

2. Open the Properties dialog box, and click the Output tab.

3. Click Job Settings... to access the Job Settings dialog box.

4. Select the Job Storage (e-MPS) check box. Select Temporary or Permanent.

5. Click Options... to open the Job Storage Options dialog box.

6. Select the Barcode check box. Select Print first page only or Print all pages.

{28L016T50}
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7. If you want to print the job ID as characters with the barcode, as shown in the diagram 
below, enable the Print Barcode ID check box.

8. From the Position drop-down list, select the barcode position on the page. From the 
Orientation drop-down list, select the direction of the barcode.

9. Click OK.

The combinations of barcode printing position and orientations are shown in the table 
below.

When printing, the barcode is printed in the designated position.

Reading with the Barcode Reader

When the printed job ID is read by the barcode reader, the printer outputs that page.

Orientations
Position

Upper-Right Lower-Right Upper-Left Lower-Right

Horizontal

Vertical

{28L016T50}
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• If the barcode on the front cover is read, all pages are printed. 
• If pages are read individually, only the pages that are read are printed. 

This feature requires switching the serial interface mode to work with the barcode reader. For 
further details, refer to the barcode reader's Operation Guide.

Using the Barcode Reader to Read the Job Code

Barcode Reader

Job Code
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Saving Profiles You can save print settings made on the Media, Output or other tabs in the Print dialog box. 
By creating a profile out of the saved settings, they can be easily recalled, eliminating the 
need to reset them on the dialog box tabs. Profiles can be easily added, edited, or deleted. 
Profiles from other printers can also be read. 

If a shared profile is installed when printer driver option settings are being set, its icon is 
displayed in the list on the Profile tab, and it can be shared by each printer.

Creating Profiles

Follow these steps to create a new profile. 

1. From the application’s Print dialog box, access the Properties. (Select Print from the 
File menu and select Properties.)

2. Configure the appropriate options on each setting tab. 

3. Click the Profile tab in the Properties dialog box.

4. Click Add to access the Add Profile dialog box.

5. Enter a Name for the Profile Information, and select the Icon Style. The name can be 
up to 31 characters.
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6. Select a color for the Profile Information from the Icon Color drop-down list. This 
options enables you to sort icons by color.

7. Enter comments about the settings into the Profile Information Description section. Up 
to 256 characters can be entered for the comments. 

8. Click OK to save the profile. The display returns to the Profile tab. 

9. The Profile Selections displays the icon, and name, and the Profile Information 
displays the settings and comment. Click Use to activate the displayed printer settings. 
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Editing Profiles

The Name, Icon Style, Icon Color, and Description of created and shared profiles can be 
edited. 

1. From the application’s Print dialog box, access the Properties. (Select Print from the 
File menu and select Properties.)

2. Click the Profile tab in the Properties dialog box.

3. Select the profile to be edited from the Profile Selections, and click Edit. 

4. The Edit Profile dialog box appears. Edit the profile information's Name, Icon Style, Icon 
Color, and Description. For further details, refer to Creating Profiles on page 128.

5. Click OK to save the edited profile. 
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Deleting Profiles

1. From the application’s Print dialog box, access the Properties. (Select Print from the 
File menu and select Properties.)

2. Click the Profile tab in the Properties dialog box. Select the profile to be deleted from the 
Profile Selections, and click Delete. 

3. Click OK. 

Importing and Exporting Profiles

You can save your profile on your personal computer and have it read by other printers. The 
profiles on several printers can be shared. Print results may vary depending on the printer 
model.

1. From the application’s Print menu, access the Properties. (Select Print from the File 
menu and select Properties.)

2. In the source printer driver, click the Profile tab in the Properties dialog box. 

3. Select the profile to be read from the Profile Selections, and click Export....

Read source
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4. The Export Profile dialog box appears. Save the profile. 

Specify the save location in the Save in drop-down list, enter a name for the file in the File 
name field, and click Save. Close the Properties dialog box.

5. In the destination printer driver, click the Profile tab in the Properties dialog box. Click 
Import....

6. The Import Profile dialog box appears. Select the profile from the Look in drop-down list, 
select the profile name, and then click Open.

Read source

Read Destination
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7. If a message dialog box appears displaying “Some profile settings are not applicable 
to this model. Do you want to continue?”, there are unusable functions in this profile. 
Click OK to return to the Profile tab.

The profile read by the printer driver displays in the Profile Selections, and profile 
reading is finished.

Read destination

Read destination
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Prologue/Epilogue You can configure detailed settings in the Prologue/Epilogue tab. For further details, refer to 
step 8 on page 2.The Welcome to the Kyocera Printer Installation Wizard dialog box 
appears. Click Next.

• This function hides the PRESCRIBE command in the document. This allows 
execution of settings such as printer emulation and foreign characters or overlays. 

• Insert Location specifies the location for burying the PRESCRIBE command, such 
as at the start or end of the document. 

• The Page Start and Page End options can be used only when PCL 5e or PCL 5c are 
specified for the PDL in the PDL Settings dialog box. The file box items can also be 
added, edited, and deleted.
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Setting Information You can confirm settings made on the Media, Layout, Imaging, Color, Output, Prologue/
Epilogue, Watermark, and Device Settings tabs. 

By simply clicking Setting Information... on the Printing Preferences/Properties dialog 
box, current driver settings can be displayed in a tree view.

Displayed settings may vary depending on the PDL.
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Table of Supported Options

Printers

Model

Enhancement Unit

A Paper Feeder
B Envelope Feeder Duplex unit Document 

Finisher

A Face-Down Stacker
B Offset Stacker
C Face-Up Stacker
D Sorter Stacker

Document 
Processor

FS- 1010 A PF-17 x 1
FS- 1018MFP A PF-17 x 1 DP-100
FS- 1020D A PF-17 x 1
FS- 1050 A PF-17 x 1
FS- 1118 / 
KM- 1820

PF-17 x 1 None None None

FS- 1900
A PF-60 x 3 or
A PF-8E
B EF-60

DU-60 A HS-8E
D SO-60

FS- 1920 A PF-60 x 3
B EF-60

DU-60 D SO-60

FS- 3820N A PF-60 x 3
B EF-60

DU-60 D SO-60

FS- 3830N
A PF-60 x 3 or
A PF-8E
B EF-60

DU-61 D SO-60

FS- C5016 A PF-60 x 3
B EF-60

DU-300

FS- 6020 A PF-400 x 4 DU-400
FS- 6026 A PF-400 x 4 DU-400

FS- C8008 A PF-30A x 3 PD-800 DF-31 B ST-30
D SO-60

FS- C8026N
A PF-640 x 2
A PF-645 x 1
A PF-647 x 1

DU-640

FS- 9100DN
A PF-70 x 2
A PF-75 x 1

Standard DF- 70E/70U
DF- 71E/71U
DF- 75

FS- 9500DN
A PF-70 x 2
A PF-75 x 1

Standard DF- 70E/70U
DF- 71E/71U
DF- 75

FS-9120DN
A PF-70 x 2
A PF-75 x 1

Standard DF- 71E/71U
DF- 73
DF- 75

D M-2107

FS- 9520DN
A PF-70 x 2
A PF-75 x 1

Standard DF- 71E/71U
DF- 73
DF- 75

D M-2107

Ci1100 A PF-81 x 1 DU-81
FS-1000 A PF-17 x 1
FS- 1000+ A PF-17 x 1
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FS- 1200
A PF-20/21 x 2
A PF-7E x 1

DU-21 A ST-20
C HS-3E
D SO-6

FS- 1700+
A PF-20 x 2 or
A PF-7E x 1
B EF-1

DU-20 A ST-20
C HS-3E
D SO-6

FS- 1714M
A PF-21 x 2 or
A PF-7E x 1
B EF-1

DU-21 A ST-20
C HS-3E
D SO-6

FS- 1750
A PF-21 x 2 or
A PF-7E x 1
B EF-1

DU-21 A ST-20
C HS-3E
D SO-6

FS- 1800
A PF-60 x 3 or
A PF-8E
B EF-60

DU-60 A HS-8E
D SO-60

FS- 1800+
A PF-60 x 3 or
A PF-8E
B EF-60

DU-60 A HS-8E
D SO-60

FS- 3700+
A PF-20 x 2 or
A PF-7E x 1
B EF-1

DU-20 A ST-20
C HS-3E
D SO-6

FS- 3718M
A PF-21 x 2 or
A PF-7E x 1
B EF-1

DU-20/21 A ST-20
C HS-3E
D SO-6

FS- 3750
A PF-21 x 2 or
A PF-7E x 1
B EF-1

DU-20/21 A ST-20
C HS-3E
D SO-6

FS- 3800
A PF-60 x 3 or
A PF-8E
B EF-60

DU-60 A HS-8E
D SO-60

FS- 5900C A PF-81 x 1 DU-81
FS- 6750 A PF-26 x 2 DU-25
FS- 6900 A PF-26 x 2 DU-25

FS- 7000+ A PF-30 x 3
B EF-1/UF-1

DU-30/31 DF-30/31 B ST-30
D SO-30

FS- 7028M A PF-30 x 3
B EF-1/UF-1

DU-30/31 DF-30/31 B ST-30
D SO-30

FS- 8000C A PF-30A x 3 PD-30 DF-31 B ST-30
D SO-30

FS- 9000 A PF-30 x 3
B EF-1

DU-31 DF-31 B ST-30
D SO-30

Model

Enhancement Unit

A Paper Feeder
B Envelope Feeder Duplex unit Document 

Finisher

A Face-Down Stacker
B Offset Stacker
C Face-Up Stacker
D Sorter Stacker

Document 
Processor
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Copier/MFP

Model

Enhancement Unit

A Paper Feeder
B Optional Feeder Duplex Unit Job Separator

A Inner Finisher
B Finisher
C Booklet Stitcher
D Mailbox Unit

Tandem Unit

KM-1510 A ST-13 x 1
B ST-13 x 1

KM-1530 A ST-12 x 1
B ST-12 x 3

J-1302

KM-1810 A ST-13 x 1
B ST-13 x 1

KM-1815 A PF-17 x 1

KM-2030 A ST-12 x 2
B ST-12 x 2

AD-62 J-1302 A F-2205

KM-2530

A PF-70 x 2
B PF-70 x 2 or
B PF-75

AD-63 J-1402 A DF-78
B DF-71
C DF-75
D M-2107

KM-C2630/ 
C2630D

A PF-640 x 1
B PF-640 x 2
B PF-645 x 1
B PF-647 x 1

B DF-600
B DF-610
D MT-1 (Multi Tray)

KM-3035

A PF-70 x 2
B PF-70 x 2 or
B PF-75

Standard J-1402 A DF-78
B DF-71
B DF-73
C DF-75
D M-2107

KM-3530

A PF-70 x 2
B PF-70 x 2 or
B PF-75

AD-63 J-1402 A DF-78
B DF-71
C DF-75
D M-2107

KM-4030

A PF-70 x 2
B PF-70 x 2 or
B PF-75

AD-63 J-1402 A DF-78
B DF-71
C DF-75
D M-2107

KM-4230
A MD-10 x 2
B MD-10 x 2
B ST-8

Standard B F-4130/4330
C F-4220

KM-4035

A PF-70 x 2
B PF-70 x 2 or
B PF-75

Standard J-1402 A DF-78
B DF-71
B DF-73
C DF-75
D M-2107

KM-4530

A Standard Standard B DF-600
B DF-610
B BF-1
D MT-1 (Multi Tray)

TS-1

KM-5035

A PF-70 x 2
B PF-70 x 2 or
B PF-75

Standard J-1402 A DF-78
B DF-71
B DF-73
C DF-75
D M-2107
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KM-5230 A MD-10 x 2
A ST-8

Standard B F-4130/4330
C F-4220

KM-5530
A Standard
B ST-11

Standard B DF-610
B BF-1
D MT-1 (Multi Tray)

TS-1

KM-6230
A MD-10 x 2
A ST-8
B ST-11

Standard B F-4130/4330
C F-4220
D M-2107

TS-1

KM-6330
A MD-10 x 2
A ST-8
B ST-11

Standard B DF-610
B BF-1
D MT-1 (Multi Tray)

TS-1

KM-7530
A MD-10 x 2
A ST-8
B ST-11

Standard B DF-610
B BF-1
D MT-1 (Multi Tray)

TS-1

KM-C830 A PF-30A
B PF-30A

PD-30 B DF-35

KM-C850 A PF-30A
B PF-30A

PD-30 B DF-35

Model

Enhancement Unit

A Paper Feeder
B Optional Feeder Duplex Unit Job Separator

A Inner Finisher
B Finisher
C Booklet Stitcher
D Mailbox Unit

Tandem Unit
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